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Planning Your Installation

Installation Scenarios

Spectrum™ Technology Platform supports a variety of installation scenarios that scale to fit the
needs of your organization.

Standard

The standard scenario is the simplest installation scenario. You install Spectrum™ Technology
Platform on a single server. All activity is handled by this one server, including designing dataflows,
storage of configuration information, running jobs, and handling service requests.

Requests
(Such as API calls, web service requests, clients)
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Remote Servers

Remote servers are useful if you have licensed many modules. To use remote servers, you install
Spectrum™ Technology Platform on several different servers, installing different modules on each
server. You then configure the individual services to execute on one of the remote servers. This
approach has the following advantages:

* Improved performance, especially for web service and API calls. For jobs, there may be some
performance improvement, but the time it takes to send data across the network to the remote
server may offset any performance gains.

* Ability to perform database updates on individual modules without interrupting the availability of
other modules. For example, if you need to update a postal database for the Universal Addressing
Module, you could install the update by stopping just the remote server handling the Universal
Addressing Module, allowing other modules to remain available on other remote servers.

« Startup time can be reduced. With all modules on one server, it can take a long time for the server
to start up. With modules installed on separate servers, each server will start up more quickly.
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Planning Your Installation

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum™ Technology Platform goes through a load balancer. Instead of
using the URL and port of the Spectrum™ Technology Platform server, you use the URL and port
of the load balancer. Consider using this approach if you require failover redundancy and high-volume,
high-performance processing.

This diagram illustrates the cluster architecture:
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This approach has the following advantages:

(Database resource,
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Planning Your Installation

» Processing is automatically distributed among the nodes in the cluster for optimal performance.

+ Configuration settings are automatically synchronized across nodes.

» Uptime can be improved since if a node goes down the other nodes remain available to handle
processing requests.

* Adding a new node is easy.

Cluster with Separated Configuration Database

When you install the Spectrum™ Technology Platform server you are installing two things: server
software and a configuration database. The server handles the execution of jobs and service
requests, reporting, and logging. The configuration database stores data such as users and roles,
data connections, dataflows, and the audit log.

For clusters consisting of only a few nodes, installing the server and configuration database together
on the same server provides acceptable performance. However, a cluster that consists of a large
number of nodes may have its performance negatively affected by having a copy of the configuration
database on each node. This is because an increasing number of nodes results in increased data
replication between nodes during synchronization. Performance may also suffer if users are accessing
the configuration database frequently through activities such as editing dataflows or job schedules.
These activities require processing power, resulting in less CPU capacity available for running jobs
and responding to service requests.

If you have an implementation with four or more nodes, you should consider installing the
configuration database to separate servers. This is the most scalable installation scenario because
you can add nodes without necessarily adding another instance of the configuration database. For
example, say you have five nodes and three configuration database servers. You could add another
five nodes, bringing the total number of nodes to 10, while still using just the three configuration
databases to support all 10 nodes.

Installing the configuration database to a separate server has the following advantages:

» More CPU is available to the server for running jobs, process flows, and service requests because
reading and writing to the configuration database is handled by a separate server.

» Reduced network traffic due to reduced configuration data replicated between nodes. For example,
you could have five Spectrum™ Technology Platform servers for handling execution while having
only three repositories. With just three repositories instead of five, data only needs to replicate
between three servers rather than five.

» Most scalable installation scenario.

Spectrum™ Technology Platform 2018.2.0 Installation Guide 7



Requests
(Such as API calls, web service requests, clients)

Server Cluster ¢

Load Balancer

\ 4 ) 4 y v A 4
'Spectrum Node 1 'Spectrum Node 2 ISpectrum Node 3 ISpectrum Node 4 'Spectrum Node 5

N N o N 8

Configuration Database Cluster

v ‘} \d
Configuration Server 1 Configuration Server 2 Configuration Server 3
e +—>

Configuration Database Configuration Database Configuration Database

Before you install on Unix or Linux

Running as root user

Se

%

External Resources

{Database resource,

file servers, etc.)

Planning Your Installation

You cannot run Spectrum™ Technology Platform as a root user. This type of installation is no longer

supported.

You will see a prompt to designate the owner as part of the installation process.

ENTEER THE NUMBER OF THE D ED CE, OR FPRE

CEPT THE
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Planning Your Installation

« For new installations, do not install with the root user as the owner of the Spectrum™ Technology
Platform installation.

* For upgrade installations, if root is the owner of the Spectrum directory, you will have to change
the owner at installation time. If you do not change the installation ownership, the server will not
start.

Open JDK version

You must have the OpenJDK Java 8 JDK (64-bit) for AlX installed to run Spectrum™ Technology
Platform. If you do not have the OpenJDK version installed, you can download it from this site.
Follow the links to download and install the Java 8 OpenJDK (64-bit).

System Requirements

Server

Operating Systems

Supported Operating System Notes

Windows Server 2012

Windows Server 2012 R2

Windows Server 2016

Unsupported Operating Systems by Module

All modules support the Windows operating systems listed in the previous section.

Spectrum™ Technology Platform 2018.2.0 Installation Guide
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Disk Space

New Installation Upgrade

+ The disk where you are installing Spectrum™ Technology * The disk where you are installing Spectrum™ Technology
Platform must have 4 GB of free space to install all Platform must have free disk space equal to three times
modules, less if installing fewer modules. the size of your current installation. To determine the size

+ The disk where the temp folder is located must have at of your current installation, look at the size of the folder
least 10 GB of free space for the installation to extractthe ~ where you installed Spectrum™ Technology Platform.

files it needs. You may need more depending on the * If you are adding modules as part of your upgrade, you
options you are installing. If necessary, modify your TEMP  will need 3 GB to install all modules, less if installing fewer
environment variable (Windows) or IATEMPDIR modules.

environment variable (Unix and Linux) to point to a + The disk where the temp folder is located must have 10
location with enough space. GB of free space plus four times the size of your current

installation. For example, if your current installation is 5
GB, you would need 30 GB of temp space: (4 x 5 GB) +
10 GB = 30 GB. If necessary, modify your TEMP
environment variable (Windows) or IATEMPDIR
environment variable (Unix and Linux) to point to a
location with enough space.

Note: If you are installing a module that uses a reference database, such as a postal
database, geocoding database, or data normalization tables, you will need space for this
data. The total disk space varies, depending on which modules and databases you are
installing.

Memory

» Basic memory requirement: 16 GB
» The Data Normalization Module and Universal Name Module require additional memory if you
use these name databases:

* Arabic Plus Pack: 5.5 GB

 Asian Plus Pack - Chinese: 32 MB

* Asian Plus Pack - Japanese: 1.6 GB
* Asian Plus Pack - Korean: 8 MB

* Core Names: 1.1 GB

» The minimum memory requirement for the Machine Learning Module is 1 GB RAM. The allocation

(java process — jvm memory) should be three to four times the size of the input file used in jobs
where models are created.

To increase the JVM memory of the Machine Learning Module, open the

$install home$\server\modules\machinelearning\java.vmargs file and setthe -Xmx

and -Xms parameters so that -Xmx is three to four times the size of the input file used in jobs
where models are created, for example:

Spectrum™ Technology Platform 2018.2.0 Installation Guide

10



Planning Your Installation

-Xmsdefinitionm -Xmxdefinitiong

Additional Requirements

» Windows administrator rights are required to install .

* In order to use the enhanced system tray notification application the server must have .NET
Framework 3.5 SP1 (also known as 3.5.1) or higher. Current versions of Windows Server come
with the required version of .NET Framework.

System Requirements for Enterprise Geocoding and Global Geocoding modules
» The Enterprise Geocoding Module and Global Geocoding Module system requirements:

* minimum: 16 GB RAM, 4 CPU, 100 GB storage
» recommended 32 GB RAM, 8 CPU, 200 GB storage, sufficient for all datasets.

The amount of RAM will depend on how many users on the sytem and how many datasets are
loaded.

Requirements for the Big Data Integration Module

For the stages using Hadoop, which are Read from Hive File, Read from Hadoop Sequence,
Write to Hadoop Sequence, and Write to Hive File, and for the activities Run Hadoop MapReduce
Job and Run Hadoop Pig:

» Hadoop version 2.6 and above
For the activities using Spark, which are Submit Spark Job and Spark Sorter:
» Spark 2.0.1 and above.

Network Ports

The Spectrum™ Technology Platform server uses several network ports for communication. Network
port conflicts can result in module components failing to start. One indication that a component has
failed to start is if it does not appear in Management Console. To troubleshoot the problem, look in
the Spectrum™ Technology Platform wrapper log. This log shows which port is causing the problem.
You can find the Spectrum™ Technology Platform wrapper log in:

server\app\repository\logs\wrapper.log
You can change the ports by modifying the properties in this file and restarting the server:
server\app\conf\spectrum-container.properties

Note: In a clustered environment you must modify the spectrum-container.properties
file on each node in the cluster.

Spectrum™ Technology Platform 2018.2.0 Installation Guide 1
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Description

5001

This port is used by the Spectrum™ Technology Platform configuration database.
To use a different port in a non-clustered environment, modify this property:
spectrum.repository.server.coordinator.port

To use a different port in a clustered environment:

» Specify the port you want instead of 5001 in
spectrum.repository.server.coordinator.port.

» Specify the seed nodes for the configuration database in
spectrum.repository.server.cluster.seeds.

5701

This port is used by Hazelcast for managing distributed processing between Spectrum™
Technology Platform servers in a cluster.

To use a different port in a non-clustered environment, modify this property:
spectrum.hazelcast.port
To use a different port in a clustered environment:

+ Specify the port you want to use instead of 5701 in spectrum.hazelcast.port.

* Include the Hazelcast port number after each IP address specified in
spectrum.cluster.seeds. Forexample, if spectrum.hazelcast.port
is set to 5702 and the IP address of a seed node is 1.2.3.4.5, you would specify
1.2.3.4.5:5702inspectrum.cluster.seeds.

6362

This port is used if you enable backups of the Spectrum™ Technology Platform configuration
database. To use a different port, modify this property:

spectrum.backup.http.port

7474

This port is used by the Spectrum™ Technology Platform configuration database. To use a
different port, modify this property:

spectrum.repository.server.connector.http.port

7687

This port is used by the Spectrum™ Technology Platform configuration database. To use a
different port, modify this property:

spectrum.repository.server.connector.bolt.port

8080

The port used for communication between the server and Enterprise Designer and Management
Console. This port is also used by web services. To use a different port, modify this property:

spectrum.http.port

Spectrum™ Technology Platform 2018.2.0 Installation Guide
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Port Description

9200 This port is used by the search index engine used by the Advanced Matching Module. To use
a different port, modify this property:

spectrum.index.http.port

9300 This port is used by the search index engine used by the Advanced Matching Module.
To use a different port in a non-clustered environment, modify this property:
spectrum.index.tcp.port

To use a different port in a clustered environment:

+ Specify the port you want to use instead of 9300 in spectrum. index.tcp.port and
after the colon in spectrum.index.client.addresses.

+ Specify the seed nodes for the search index in
spectrum.index.server.cluster.seeds.

10119 This port is used for API calls made to services. To use a different port, modify this property:

spectrum.socketgateway.port

15431-15432 These ports are used by the Machine Learning Module.

32751 This port is used for ODBC connections model stores which are created in Metadata Insights.
To use a different port, modify this property:

spectrum.metadata.odbc.port

Enterprise Designer

Enterprise Designer requires the following:
» Operating system requirements:

* Windows 7
* Windows 10

+ 86 MB of disk space to install Enterprise Designer without any modules. Each module you install
requires additional disk space.

« Microsoft .NET Framework 4.6 (available from the Spectrum™ Technology Platform Welcome
Page, http://<SpectrumServerName>:8080)

* A monitor with at least 1024 x 768 resolution

» Maximum Windows DPI setting: 150%
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» Adobe Reader 7 or later (for viewing and saving reports)

Web Browsers

* Internet Explorer 11
» Google Chrome 70.0 or later
* Mozilla Firefox 62.0 or later

» To use the Data Hub Relationship Analysis Client, a browser with Microsoft Silverlight 5 installed.
See www.microsoft.com/getsilverlight. Because Google Chrome no longer supports Microsoft
Silverlight, you will need to access these client tools using Internet Explorer or Firefox.

Command Line Tools

Administration Utility

Note: The Administration Utility requires Java 8 or later. Verify that Java 8 is in the system's
path before running the Administration Utility.

Job Executor and Process Flow Executor

The Job Executor and Process Flow Executor command line tools require Java 8 or later.

User Interface Languages

Spectrum™ Technology Platform user interfaces such as Management Console, Enterprise Designer,
and web applications are localized for these languages:

* English

* French

» German
» Japanese
» Spanish

Client SDK

The Client SDK provides API access to Spectrum™ Technology Platform services. To use the Client
SDK your computer must meet the following requirements:

Spectrum™ Technology Platform 2018.2.0 Installation Guide 14
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» 1.25 GB disk space

» JDK 1.8 is required to install the Client SDK. Be sure that JDK 1.8 is in the PATH environment
variable. Once installed, the Client SDK supports JDK 1.8 and greater.

Supported Compilers

The Spectrum™ Technology Platform Client SDK is supported with the following compiler and
runtime minimum versions.

Java

Client SDK Package Directory: clientSDK/platforms/java

Client SDK requires the Java JDK, version 1.8 or higher. This is not installed with the Client SDK.

Windows 64-bit

« JDK: 1.8
+ C Compiler: MSVC 2005, MSVC 2008
» C++ Compiler: MSVC 2005, MSVC 2008

HP-UX RISC

+ JDK: 1.8
» C Compiler: cc: HP92453-01 A.11.01.21 HP C (Bundled) Compiler
+ C++ Compiler: aCC: HP aC++ B3910B A.03.30 HP aC++ B3910B A.03.27

The clientSDK 64-bit lib is linked to these libraries:

* libpthread.1
* libnsl.1

* librt.2

* libdl.1

* libc.2

* libxti.2

* libdl.1

HP-UX Itanium

« JDK: 1.9
» C Compiler: cc: HP aC++/ANSI C B3910B A.06.05
» C++ Compiler: aCC: HP aC++/ANSI C B3910B A.06.05

The clientSDK 64-bit lib is linked to the following libraries:

* libpthread.so.1
* libnsl.so.1
* librt.so.1

Spectrum™ Technology Platform 2018.2.0 Installation Guide
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* libxti.so.1
¢ libdl.so.1

Red Hat (64-bit)

* Operating System: Red Hat Linux version 2.6.9-34.0.2.ELsmp
» C Compiler: gcc version 3.4.5
» C++ Compiler: g++ version 3.4.5

The clientSDK lib is linked to the following libraries:

* libstdc++.50.6

* libm.so0.6

* libgcc_s.s0.1

* libpthread.so.0

* libc.s0.6

* |d-linux-x86-64.s0.2

SuSE

» Operating System: SUSE SLES 8 (powered by UnitedLinux 1.0) (i586)\nKernel 2.4.21-295-smp
(0).

» C Compiler: gcc version 3.2.2

» C++ Compiler: g++ version 3.2.2

Solaris

* Operating System: Solaris 5.8
» C Compiler: cc: Forte Developer 7 C 5.4 2002/03/09
» C++ Compiler: CC: Forte Developer 7 C++ 5.4 Patch 111715-16 2005/04/28

The clientSDK 64-bit lib is linked to the following libraries:

* libpthread.so.1
* libsocket.s0.1
* libnsl.so0.1

* librt.so.1

* libc.so0.1

* libmp.so.2

* libmd5.s0.1

* libscf.s0.1

* libaio.so.1

* libdoor.so.1

* libuutil.so.1

* libm.so0.2

* libc_psr.so.1
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* libmd5_psr.so.1

AlX

» Operating System: AIX version 5.1.0.0
» C Compiler: xlc 6.0 Visual Age C 6.0
» C++ Compiler: xIC 6.0 Visual Age C++ 6.0

The clientSDK 64-bit lib are linked to the following libraries:

* libC.a

* libc_r.a

* libpthread.a
* librtl.a

Location Intelligence Module Support

Database

The Location Intelligence Module supports the following spatial databases for use with the spatial
services, data, and resources:

* Oracle 11gR2, Oracle 12C
« SQL Server 2012, 2014, and 2016
* PostgreSQL 8+ (PostGIS 2.x)

Note: Spectrum Spatial requires the PostGIS extension for PostGreSQL data source
provider even if spatial capability will be not needed or used.
» GeoPackage (Windows and CentOS)
Note: SAP HANA is no longer supported.

Data Format
The Location Intelligence Module supports the following data formats for use with the spatial services:

» Generic JDBC (with XY)
» TAB (native, native extended, raster, grid, seamless, DBF)
» ESRI shapefile

Raster Format
The following raster and grid formats (64-bit only) are supported in the Location Intelligence Module:

Raster formats:
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Format File Extension
ADRG .gen

ASRP .gen

BMP .bmp, .wbmp
CADRG .gen

CiB various
ECW (SDK v5) .ecw

GeoTiff .geotif

GIF .gif

JPEG Jjpg/.jpeg
MrSID (SDK v9) .sid

Note: Supports MG4 (MrSID Generation 4). On CentOS
7.1, libpng12.so is required for reading MrSID rasters.

NITF .ntf
PNG .png
TIFF tif

Note: TIFF files used by the Feature Service and
Mapping Service cannot exceed 2GB.

Note: Solaris or AIX machines, whether installed with 32- or 64- bit JVM, do not support
ECW and MrSID raster formats.

Grid Formats

Format File Extension
Defense Digital Terrain Elevation Data (DTED) .dto, .dt1, .dt2, .dt3
Maplnfo Grid .mig

MRR (Multi-Resolution Raster) .mrr

Note: This support is provided on Windows.

Note: This support is provided on the following Linux
environments:

e Oracle Linux 6.5 and 7.1
* CentOS 6.4 and 7.1
e Ubuntu 14.04, 16.04, and 18.04

Spectrum™ Technology Platform 2018.2.0 Installation Guide 18
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Vertical Mapper Classified Grid |.grc
Vertical Mapper Continuous Grid | .grd

In order to use rasters and grids as a map layer, there must be an associated .TAB file containing
georeference information about the image, including the bounds, coordinate system, and registration
points.

Utilities

The Location Intelligence Module utilities (Tile Generator, WMTS Tile Generator, and the Geometry
Validator) require at a minimum Java 8. If you are installing these utilities on the same computer
where the Spectrum™ Technology Platform server is installed, Java 8 will be installed since it is
included with the server. If you want to install the utilities on another computer, make sure that the
computer has Java 8 or later installed.

Samples
The .NET samples require at a minimum Visual Studio 2013 and Microsoft .NET Framework 4.5.

Maplinfo Professional Compatibility

The Location Intelligence Module is compatible with MapInfo Professional up to version 16.x and
17.x. See Tools > Maplnfo Pro in the Spectrum Spatial Getting Started Guide for more information
about the interoperability of the two products.

Internet Explorer

To use Internet Explorer 11, uncheck Display intranet sites in Compatibility View in the
Compatibility View settings.

WebDAV

When communicating to the server over HTTPS to map a drive to the repository, a WebDAV client
is required to use the TLS v1.2 protocol.

For client machines running on Windows 7 SP1, Windows Server 2008 R2 SP1, and Windows
Server 2012, you must apply a security patch and registry update to leverage this protocol. For
instructions, see the "Managing Security" chapter in the Administration section of the Spectrum
Spatial Guide.
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Standard Installation

Installing a New Server

Prerequisites:

« Before installing Spectrum™ Technology Platform, be sure to read the Release Notes. The Release

Notes contains important compatibility information as well as release-specific installation notes.

» Apply all the latest updates available for your operating system, especially those that resolve

issues with Java.

* You may encounter installation problems on Windows if the data execution prevention (DEP)

setting is not set correctly. The DEP setting must be set to Turn on DEP for essential Windows
programs and services only. For instructions on how to change your DEP setting, see the
Windows documentation.

To install a new server:

1.

Download Spectrum™ Technology Platform using the download instructions contained in your
welcome letter.

Extract the downloaded file to a temporary location on the server where you want to install
Spectrum™ Technology Platform.

Double-click install.exe.

The installer guides you through the installation process. Note the following:

The installer guides you through the installation process. Note the following:

* If you are setting up an environment where the configuration database is installed on a separate
server choose Server only. Otherwise choose Standard installation.
* When prompted, select the modules that you want to install.

+ Make sure that Spectrum™ Technology Platform is selected.

+ If you are installing the SAP Module you must install Advanced Matching Module. The
Enterprise Tax Module is optional. The Universal Addressing Module is only required if
you will be using the SAP module service SAPValidateAddressWithCandidates.

* When prompted, enter the HTTP port that you want to use then press Enter. The default is
8080. For a complete listing of ports used by Spectrum™ Technology Platform see Network
Ports on page 11.

Unless you are installing a cluster and you cleared the check box to start the server after
installation, the Spectrum™ Technology Platform server starts when the installation is complete.
Wait for the server to start.

Spectrum™ Technology Platform 2018.2.0 Installation Guide
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You can see when the server has fully started by opening the log file <Spectrum
Installation Location>\server\app\repository\logs\wrapper.logandlooking
for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform (Version
version build) Started

Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

Install your license key. For more information, see Installing a License Key on page 29.

Apply all the updates for the platform and any modules you have installed. For a listing of
updates, see the Update Summary on the Pitney Bowes support website.

Upgrading a Server

Prerequisites:

» Before upgrading, be sure to read the release notes for the new version. The release notes contain

a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve

issues with Java.

* IMPORTANT: We recommend that you create a backup before upgrading so that you can recover

your flows, security settings, and other settings, if an error occurs during the upgrade process.

This procedure is for upgrading a single Spectrum™ Technology Platform server. Follow this
procedure when upgrading a standard installation or when upgrading a node in a cluster. If you are
upgrading a cluster, be sure to follow the cluster upgrade process. For more information, see
Upgrading a Cluster on page 50.

If you use remote servers, you must upgrade the remote servers and start them before upgrading
the main server. If you upgrade the main server and start it before upgrading and starting the remote
servers, you will need to recreate the remote server connections in Management console after
upgrading.

1.

Download the updated version of Spectrum™ Technology Platform using the download
instructions contained in the release announcement email.

Unzip the downloaded installer to a temporary folder on the server you want to upgrade.
Back up the server. For instructions on creating a backup, see the Administration Guide.
Back up module-specific data for any of these modules if you have them installed.
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Module Items to Back Up
Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumLocation/server/modules:
» cdgdb
« Jucene

» matcher

* parser

« searchindex
« tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

« server\modules\hub\hub.properties
+ server\modules\db\neod]j.properties

Location Intelligence Module Back up your named resources, data, and configuration
files.

(Optional) You can reduce the time it takes to upgrade your system by purging old records from
the execution history. Consider purging the execution history if it contains over 100,000 entries.
You can view your execution history in Enterprise Designer under View > Execution History.

If you are upgrading from 9.0 SP3 or 10.0 SP1, delete old history records manually using
Management Console.

If you are upgrading from version 11.0, 11.0 SP1, or 12.0, use the JMX console to delete old
history records. This process is faster than manually deleting records in Management Console,
but is only available on versions 11.0, 11.0 SP1, and 12.0. For more information, see Purging
Execution History on page 25.

Stop the Spectrum™ Technology Platform server. To stop the server, right-click the Spectrum™
Technology Platform icon in the Windows system tray and select Stop Spectrum™. Alternatively,
right-click the Spectrum™ Technology Platform icon in the Windows system tray (shown below)
and select Stop Spectrum™.
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7. Wait for the server to finish the shutdown process before proceeding.

Important: If you have the Data Hub Module installed, make sure that all models are stopped.
Models that do not shut down properly will not open successfully after upgrading.

8. Ifyou have the Global Sentry Module installed, stop the Global Sentry database server by going
to the Windows services control panel and stopping the Global Sentry Database Server service.

9. Run the Spectrum™ Technology Platform installer to upgrade your system.

10. Apply all the updates for the platform and any modules you have installed. For a listing of
updates, see the Update Summary on the Pitney Bowes support website.

Note: Any job or subflow stored in the system during a server upgrade is marked as exposed
to provide the same behavior for those jobs and subflows as before the upgrade. Any job or
subflow that is exported prior to the upgrade will not be exposed. Therefore, when importing
these jobs or subflows back into the system, you must manually expose the imported job or

subflow.

Some modules have post-upgrade steps you need to perform.

Data Hub Module

Open this file in a text editor:
server/modules/hub/neo4j.properties
and set the property

dbms.allow format migration property to
true. The purpose of this property is to protect against
unintentional and irreversible store upgrades. Setting this
property to "true" indicates that you understand the
ramifications of proceeding with an upgrade and have taken
the necessary precautions before proceeding.

Restart the Spectrum™ Technology Platform server. The
server will upgrade each model. Examine the file

server/app/repository/logs/wrapper.log
for errors or warning messages. Once all models have been
upgraded, go back to the hub .properties file and

commentoutthe allow store upgrade property.
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Purging Execution History

If you have many flows, or services that are used frequently, the execution history in Management
Console can become quite large. This procedure describes how to remove old records from the
execution history. You may want to purge old records to reduce the size of the configuration database.
Purging records before upgrading to a new version can help reduce the time it takes to upgrade
Spectrum™ Technology Platform.

There are two purge methods:

» Purge records: com.pb.spectrum.platform.configuration:manager=Archive TransactionManager
* Purge records and provide archive status:
com.pb.spectrum.platform.transaction:manager=archive TransactionManager

The steps below demonstrate the "purge records" (non-archive status) request.

1. Open aweb browser and goto http://server:port/jmx-console
Where:
server is the IP address or hostname of your Spectrum™ Technology Platform server.

port is the HTTP port used by Spectrum™ Technology Platform. The default is 8080.

2. Under Domain: com.pb.spectrum.platform.configuration, click
com.pb.spectrum.platform.configuration:manager=ArchiveTransactionManager.

3. (Optional) If you want to save an archive of the history that you are going to purge, specify the
path where you want to save the archive in the ArchiveDirectory field, then click set. Then,
set ArchiveEnabled to true and click set.

4. In the ArchiveRetain field, specify how many days of records you want to keep in the history
then click set. For example, if you enter 45 then history records that are 45 days old or newer
will be retained, and records 46 days old and older will be purged. To determine how many days
of records you can retain, look at the job and process flow history in Enterprise Designer and
identify the point in time where the number of records exceeds 100,000.

5. (Optional) If you want to schedule a purge to occur on a regular schedule, enter the schedule
in the CronExpression field using a Cron expression.

A cron expression consists of six space-separated values, with an optional seventh value:

Seconds
Minutes

Hours

Day of the month
Month

Day of the week
Year (Optional)
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For example, this expression would purge the flow and transaction history at midnight every
Sunday:

0 00 ? * SUN

For more information about cron expressions, see quartz-scheduler.org/documentation.

After specifying a cron expression, click the set button next to the CronExpression field, set
PurgeEnabled to true, and click the set button next to the PurgeEnabled field.

Note: You do not need to schedule purges if you want to purge the history only one time
for the purposes of speeding up the upgrade process.

6. (Optional) If you want to set a maximum number of records to remain in the history after the
purge, specify the maximum number of records in the MaxHistoryRecordCount field. This is
useful if you have a large number of history records each day, and even after purging old records
based on the value in the ArchiveRetain field, the size of the execution history is still larger
than you want. After purging the old records based on the value in the ArchiveRetain field,
additional records will be purged until the number of records that remains is equal to the number
in the MaxHistoryRecordCount field. If you do not want to specify a maximum number of
history records, specify -1.

Note: The limit you specify in MaxHistoryRecordCount sets the limits for process flows
and jobs separately. For example, if you specify 5000, the maximum number of process
flow history records will be 5,000, and the maximum number of job history records will
be 5,000, for a total maximum number of 10,000 records.

7. In the PurgeOperation field, leave the value set to ALL.
8. Select All MBeans to return to the main JMX Console screen.

9. Under Domain: com.pb.spectrum.platform.configuration, select
com.pb.spectrum.platform.transaction:manager=ArchiveTransactionManager.

10. To run the purge, click Invoke.

You have purged flow and execution history so that you now have a smaller configuration database.
Upgrade Steps for Profiling and Search Index Users

Note: This process will add some time to the upgrade, as all existing indexes are upgraded
to a newer version. This time will depend on the data stored in Search Index.

You are required to first export your indexes before upgrading to this release, then import those
indexes after upgrading. Scripts are provided to assist with the manual steps. You must use a
semi-manual process to migrate your indexes to maintain compatibility with the current version of
Elasticsearch.
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Note: The manual (script-based) steps require the server or cluster to be up and running.
Do not stop the server until the point noted in this process.

Scripts provided

The Delete, Export, and Import scripts are located in the utilities folder where the Spectrum Installer

is placed.

Function

Script or file name

Delete indexes

* Unix/Linux - delete-all-indexes.sh
* Windows - delete-all-indexes.bat

Export indexes

» Unix/Linux - export.sh
* Windows - export.bat

Import indexes

Prerequisites for these upgrades

Unix/Linux - import.sh
» Windows - import.bat

» The export directory should be empty, and should not include hidden files.
» The JAVA_HOME environment variable should be set.

Migrate your indexes

Note: It is mandatory to apply all the product updates available for Advanced Matching
Module for versions 11.1, 12.2, and 12.2.1 before using these utilities. For upgrading version
10.1, refer Additional Steps for Spectrum™ Technology Platform version 10.1 on page

29

Follow these steps to set the necessary variable and upgrade then re-import your current indexes.

1. Setthe JAVA HOME environment variable to point to a Java JDK8 or later.

Note: If you do not set this variable, your export or delete index actions may fail.

2. Export all current indexes using the export script.

Unix/Linux example:

sh export.sh <spectrum dir> <export dir>

Windows example:

export.bat <spectrum dir> <export dir>

where:
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* spectrum_diris the full path to the Spectrum installation: This location includes the /server,
/index, and /repository directories.

* export diris the full path to the directory to which indexes will be exported.

This will extract all indexes currently stored in Elasticsearch and write them to a local directory
accessible by one of the servers. In a clustered environment, do this only on one node.

Once your Export runs without error, run the delete-all-indexes script to clear all indexes from
the running instance of Elasticsearch.

Unix/Linux example:
sh delete-all-indexes.sh <spectrum dir> <export dir>
Windows example:

delete-all-indexes.bat <spectrum dir> <export dir>

where:

* spectrum_dir is the full path to the Spectrum installation.
» export diris the full path to the directory to which indexes have been exported.

Once the Delete step has completed successfully, it is safe to shut down your Spectrum node
or cluster.

Run the software upgrade process as you would with previous releases of Spectrum™
Technology Platform.

Note: The upgrade process looks for existing indexes. If indexes are found, the installer
will generate an error message and will stop the upgrade process.

Once the upgrade is complete, restart the server.

Import back the indexes using the import script. In a clustered environment, this should be
done only on one node.

Unix/Linux example:

sh import.sh <spectrum dir> <import dir>
Windows example:

import.bat <spectrum dir> <import dir>

where:

» spectrum diris the full path to the Spectrum installation.
* import diris the full path to the directory from which Spectrum indexes will be imported.
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Additional Steps for Spectrum™ Technology Platform version 10.1
Follow these steps while upgrading from version 10.1 to the latest version:

Note: Stop the Spectrum™ Technology Platform server before performing the first step
mentioned below.

1. Set the http.enabled setting as true in the elastic search file. It is set to false by default. This file
is located at:
<SpectrumLocation>\server\modules\searchindex\elasticsearch.yml

Start the Spectrum™ Technology Platform server.

Access searchindex by running any SEARCH job. This will initialize the search engine.

Export the 10.1 indices using the utility provided and explained above.

Upgrade from version 70.17 to the latest version.

o rowbd

Installing a License Key

The license key provides access to software pursuant to the terms of your license. Itis an encrypted
XML file with a file name ending in . key.

Note: When you upgrade an existing Spectrum™ Technology Platform installation, you may
continue to use your existing license key. You do not need to get a new one.

To install a license key:
1. Locate the email containing your license key that you received from Pitney Bowes.

Important: You must install the license key within 45 days of receiving it. If you do not you will
need to contact Pitney Bowes for another license key.

2. Copy the . key file to the following directory:
<SpectrumPlatformLocation>\server\app\import

The license key is applied to your system. There is no need to restart your server.

If there was a problem installing the license key, check the log file in:
<SpectrumPlatformLocation>\server\app\repository\logs

Depending on whether the key was processed successfully or there was an error processing the
key, the processed key goes into one of these folders:

* <SpectrumPlatformLocation>\server\app\import\archive\license-keys
* <SpectrumPlatformLocation>\server\app\import\error\license-keys
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Installing the Server with a Silent Installer

The silent install process for the server allows you to pre-configure the server installation process
so that it runs without user intervention. Instead of responding to prompts for information such as
the installation location and which modules to install, you specify these responses in a properties
file which the installer uses instead of user prompts.

In the Spectrum™ Technology Platform installer, go to the folder SilentInstaller.
2. Openthefile installer.properties in a text editor.

3. Editinstaller.properties as necessary to specify the installation settings you want to
use. See the comments in installer.properties for additional information.

4. To run the installer in silent mode, place installer.properties in the same directory as
install.exe. When the installer runs it will detect installer.properties and automatically
run in silent mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the -f argument, as follows:

install.exe -f PathOfPropertyFile\installer.properties

Adding Modules

Spectrum™ Technology Platform is designed so that modules can be added as you grow your
system over time. For example, you may have one Spectrum™ Technology Platform module, then
license another module a few months later. The second product may be built on a newer version
of Spectrum™ Technology Platform. This will require you to upgrade your version of Spectrum™
Technology Platform. In another case, the second product is compatible with the installed version.
In both cases, the install program recognizes if it needs to upgrade Spectrum™ Technology Platform
and will do so without prompting. If an upgrade is not required, the installer will skip the Spectrum™
Technology Platform install steps and install the new module.

The process for adding a module is similar to that of a new installation. In both cases you start the
installation process by running the Spectrum™ Technology Platform installer. Note that Spectrum™
Technology Platform modules do not have their own installer. Instead, you use the Spectrum™
Technology Platform installer to add modules.

1. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows system tray (shown below) and select
Stop Spectrum™.
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2. Launch the Spectrum™ Technology Platform installer by double-clicking Install.exe. The
installer guides you through the installation process. When prompted, select the modules that
you want to install. Your currently installed modules are selected.

3. Install any necessary databases for the new product. For more information about installing
databases, see Spectrum Databases on page 82.

4. After you install the necessary databases (if any), start Spectrum™ Technology Platform by
right-clicking the Spectrum™ Technology Platform icon in the Windows system tray and selecting
Start Spectrum™.

5. Install the license key for the module. For more information, see Installing a License Key on
page 29.

Removing the Server

Before uninstalling any product, back up any files you may need in the future. Uninstalling Spectrum™
Technology Platform will remove all jobs and settings.

1. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows system tray (shown below) and select
Stop Spectrum™.

Customize...
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2. Go to Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Server and
select Uninstall Pitney Bowes Spectrum™ Technology Platform.
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Note: Some Java files will not be removed because the uninstall process itself uses
them.
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Clustered Architecture

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum™ Technology Platform goes through a load balancer. Instead of
using the URL and port of the Spectrum™ Technology Platform server, you use the URL and port
of the load balancer. Consider using this approach if you require failover redundancy and high-volume,
high-performance processing.

This diagram illustrates the cluster architecture:

Requests
{Such as API calls, web service requests, clients)

Cluster
Load Balancer
@

A 4 v ) 4
Spectrum Node 1 Spectrum Node 2 Spectrum Node 3 @ @
E— 3
Ry |

¥
=

External Resources
(Database resource,
file servers, etc.)

b
&

I
O

Configuration Database Configuration Database Configuration Database

Load Balancer

As requests come into the cluster, the load balancer identifies the best available Spectrum™
Technology Platform node to handle the request. The request is then passed to a Spectrum™
Technology Platform node.

From the user's perspective, the distributed architecture is handled automatically behind the scenes.
The user sends a request to the load balancer's URL and port for Spectrum™ Technology Platform
(typically port 80 for a distributed environment) as if it were a single Spectrum™ Technology Platform
server.

Nodes

A node is a Spectrum™ Technology Platform server installation. Each node has a copy of the
configuration database. Each copy is continuously synchronized. This enables each node to share
the same settings, such as license information, dataflows, and database resources.

To configure the cluster, simply point Management Console or Enterprise Designer to the load
balancer's URL and port for Spectrum™ Technology Platform (typically port 80 for a distributed
environment).
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The definitions for external resources such as database resources (postal databases and geocoding
databases for example), JDBC connections, and file servers, reside in the configuration database.
The resources themselves (databases, files, web services) can reside anywhere you choose.
Database resources can be installed either on each node in the cluster or on a shared network
location.

Because the database resources themselves reside outside the cluster, multiple clusters can share
the same database resources. You must create the resource definitions in each cluster using
Management Console. For example if you want multiple clusters to share the same geocoding
database, you can install the geocoding database on a server accessible from each cluster, then
in Management Console point each cluster to the geocoding database.

Installing a Cluster

See Installing a Cluster on page 38 for more information.
Clustered Architecture for the Data Hub Module

In a clustered environment, Data Hub Module graph databases are replicated to each Spectrum™
Technology Platform server in the cluster. The server that receives the first request to open a model
is the master. All other servers maintain a replicated mirror of that master. If different servers receive
requests to open different models, the masters for the models are on different servers. All writes to
the database are synchronized with the master. Any server can process read requests.

We recommend that clusters have a minimum of three servers in order to achieve a level of fault
tolerance. Also, an odd number of servers provides better individual server resiliency than an
even-numbered cluster. We make these recommendations because once the model is running, the
system will continue running as long as more than half the servers are in communication. For
example, in a cluster of six servers, four must stay in communication; for a cluster of three servers,
two must stay in communication, and for a cluster of two servers, all servers must be in
communication. Both a three-server cluster and a four-server cluster can tolerate a maximum of
one lost server.

All servers in the cluster must be available in order to open or create a model. If any server is
unavailable, the server will wait for all servers to join the cluster. If this number of servers do not
join within the timeout period, the operation fails.

Clustered Architecture for the Global Geocoding Module

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing can

Cluster

Spectrum™ Technology Platform 2018.2.0 Installation Guide

35



Cluster

be used to support high availability and scaling. The deployment architecture includes a load balancer,
Spectrum™ Technology Platform nodes with Global Geocoding Modules and Geocoding databases.

l Requests

Load Balancer
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Spectrum Node 1 Spectrum Node 2

(with Global Geocoding Module) (with Global Geocoding Module) (with Global Geocoding Module)

Spectrum Node 3

| //

| |
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Geocoding database Geocoding database

|
O

Geocoding database

Note: Each Geocoding database MUST be installed in the same location on all of the nodes
for the cluster to work properly. For example, if the Geocoding database for "Spectrum Node
1"is installed on C: \data\, then the other Spectrum nodes' Geocoding database must also

reside on C:\data\.

Clustered Architecture for the Location Intelligence Module

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing can
be used to support high availability and scaling. The deployment architecture includes a load balancer,
a Spectrum Spatial cluster, a database, and a file share. With this approach it is possible to scale

both horizontally and vertically. You can cluster the Location Intelligence Module with or without

platform clustering.

Note: Setting up both a Spectrum™ Technology Platform cluster and a Location Intelligence
Module cluster is recommended and has several benefits:

» Security (ACL) synchronization happens automatically for named resources .
» Dataflows, users, and roles created on one node will automatically synchronize to all nodes.
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« All Location Intelligence Module demo pages and utilities (such as Spatial Manager) can
and should point to the load balancer.

HTTR/HTTPS
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(Server 1) (Server 2) (Server 3)
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Database Server Map Image File Share

Load Balancer

The load balancer spreads requests between the Spectrum Spatial instances. Any load balancer
that supports load balancing HTTP/HTTPs requests can be used.

Spectrum Spatial Cluster

The cluster is a collection of Spectrum instances with the Location Intelligence Module sharing
administration, named resources, geographical metadata content and configuration settings.
Additional nodes can be added to the cluster for resilience or to deliver support for greater loads.
Each node can be scaled vertically through additional hardware resources and/or additional instances
should this be required for hardware with massive resources. Spectrum can be configured to use
restricted numbers of CPUs.
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Database

Spectrum stores named resources (maps, layers, tables and styles), geographic metadata and
configuration in a repository. In the default single server installation an embedded database is used
to store these resources on the local server. To create a resilient scalable solution this embedded
database should be replaced with a resilient independent database. Oracle, PostGreSQL/PostGIS
and Microsoft SQL Server are the supported repository databases.

In the load balanced configuration, Spectrum nodes cache these resources in a local cache and
search index in each node in the cluster. When a Spectrum node receives a request it uses the
local cache and index to find resources. Named resources can be added through any node in the
cluster. Each node keeps its cache current by checking for differences between its local cache and
the central database. This check occurs every 2 seconds by default. Time frequency can be
configured. This architecture ensures the server delivers high performance transactions and the
load on the repository database is kept to a minimum. If a new Spectrum node is added to the cluster
the cache and index are created automatically. Such a scenario can occur to remedy a node failure
or grow the capability of the deployment.

File Share

The file share provides a folder to hold map images generated by Spectrum. When maps are
rendered using the web services the server supports the map images being returned through URLs
or returned as a base 64 encoded image. When a URL is returned the map image is stored as a
file and served on request of the URL. To ensure any Spectrum node can return the map image a
file share is used to store the images.

Requirements

* A cluster should consist of at least three nodes.

+ All servers that host a node must have their system clocks synchronized in order for the cluster
to function. Verify that all systems point to the same time service to synchronize their clocks.

« All nodes in a cluster must be the same version of Spectrum™ Technology Platform so be sure
that the version you install is the same as the existing nodes.

» All nodes in a cluster must have the same modules installed.

Installing a Cluster

Installing a cluster involves setting up one Spectrum™ Technology Platform server at a time. Each
time you add a server you need to point it to an existing server which will act as a seed node. A
seed node is a server that has a copy of the Spectrum configuration data that it can copy to a new
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node so that the new node's configuration is synchronized with the other nodes in the cluster. The
following diagrams illustrate this process.

After installing the first node you will in effect have a cluster with only one node:

Cluster

Spectrum Node 1

TR

When you install the second node it must point to the first node as a seed node. This will enable
the second node to receive a copy of the first node's configuration database, resulting in a cluster
with two nodes with synchronized configuration information.

Cluster
Spectrum Node 1 Spectrum Node 2
5 — S
5 =

As you add additional nodes, the new nodes can point to any of the existing nodes as a seed node.
You must also configure the first node to point to at least one other node in the cluster so that if it
is ever brought down it can rejoin the cluster.
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Before you begin, install an appropriate load balancer. Follow the procedures described in the load
balancer's documentation when installing.

Note: The load balancer must be configured to allow encoded forward slashes. If the load
balancer does not allow encoded forward slashes you may get HTTP 404 errors while using
the cluster. For example, if you are using an Apache load balancer, you can configure it to
allow encoded forward slashes by opening the httpd. conf file and specifying this property:
AllowEncodedSlashes On. For other types of load balancers, refer to the load balancer's
documentation.

Once you have your load balancer installed, follow these steps to install nodes in the cluster.

1. Install Spectrum™ Technology Platform on a server where you want to host a node. For
instructions, see Installing a New Server on page 21.

Important: The installer will prompt you to start Spectrum™ Technology Platform after the
installation completes. You must disable this option so that the server does not start automatically
when the installation completes.

2. Configure the properties files.
a) Edit the properties in file server/app/conf/spectrum-container.properties, as
described in Cluster Properties on page 43.
b) Save and close the spectrum-container.properties file.

c) Some modules have module-specific settings that you must configure to enable the module
to work in a cluster.
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Cluster Configuration Settings

Cluster

Advanced Matching Module

These settings configure clustering for full-text search indexes. If
you do not use full-text search indexes you do not need to

configure these settings.

Open this file in a text editor:

SpectrumFolder\server\modules\searchindex\

es—-container.properties
Configure these properties:

es.index.default_number_of_replicas

es.index.default_number_of_shards

Enter the number of additional
copies you want created for
each search index. This
number should be the number
of nodes in your cluster minus
1. For example, if your cluster
has five nodes, you would
enter "4" in this property.

Enter the number of shards
you want your index to have in
the distributed environment.
The more nodes that are in
your cluster, the higher this
number should be.

Save and close
es-container.properties
when you are done editing
these properties.

Note: Search indexes created prior Spectrum™
Technology Platform 10.0 do not support clustering. To
enable clustering for indexes created prior to the 10.0
release, you must recreate the search index using the

10.0 API after modifying the
es-container.properties

file.

Spectrum™ Technology Platform 2018.2.0

Installation Guide

41



Cluster

Module Cluster Configuration Settings

Data Hub Module Open this file in a text editor:
SpectrumFolder\server\modules\hub\hub.properties
Configure these properties:

hub.models.path.base Specifies the folder where models are
stored. By default, each model is
placed in a subdirectory under the
SpectrumFolder\server\modules
\hub\db folder. If you want to store
models in a different location,
uncomment this property and specify
the folder where you want to store
models.

hub.neodj.database.type Change the value of this property to
ha. The default value embedded is for
non-clustered installations.

hub.servers.per.cluster Uncomment this line. Set the value of
this property to the number of
Spectrum™ Technology Platform
servers in the cluster.

Save and close hub . properties when you are done editing
these properties.

The SpectrumFolder\server\modules\hub\
db\neo4j.properties controls how the graph databases are
configured, using Neo4j Enterprise. This file is used as a template
for each model. If needed, each model can be configured
separately by placing a copy of this property file into the store
directory for that model.

3. Start the server. To start the server, right-click the Spectrum™ Technology Platform icon in the
Windows task bar and select Start Server.
4. Repeat this procedure to install additional nodes in the cluster.
5. Atfter installing all the nodes, go back to the first node and add the other nodes as seed nodes.
a) On the first node you installed, open the properties file
server/app/conf/spectrum-container.properties.
b) Inthe property spectrum.cluster.seeds, add the host name or IP address of the other
nodes in the cluster, separating each with a comma: ipaddress1, ipaddress2,...,ipaddressn
c) Save and close the spectrum-container.properties file. You do not need to restart
the server.
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The spectrum-container.properties file contains the properties that configure a cluster.
This table describes how to set the cluster properties for a cluster where the server and configuration
database are installed together on each node, and for nodes in the server cluster in a separated
configuration database installation. If you are setting up a configuration database cluster, see Cluster
Properties for a Configuration Database Cluster on page 68.

Property

Description

spectrum.cluster.enabled

Set this to true.

spectrum.cluster.name

If this is the first node in the cluster, set this to the name you
want to give to the cluster.

If this is not the first node in the cluster, set this to the name
of the cluster that you want this node to join. If you are
unsure of the cluster name, check the
spectrum.cluster.name property on another
node in the cluster.

spectrum.cluster.address

Specify the node's own IP address.

spectrum.cluster.seeds

If you are setting up the first node in the cluster, or if this is
the first node you are starting after having stopped the
cluster, specify only the host name or IP address of this
server. This effectively points this node to itself as a seed
node, which is necessary in order for it to be able to start
as the first node in the cluster. Do not specify 127.0.0.1.

If this is not the first node in the cluster, specify the host
name or IP address of each of the other nodes in the cluster,
including nodes that you have not yet installed. Separate
each seed node with a comma. When starting up, the node
will attempt to access each seed node in the order listed. If
none of the seed nodes can be reached, the node will not
join the cluster.

Tip: We recommend that you specify multiple seed nodes
so that if one seed node is down others can be used to allow
nodes to join the cluster. We also recommend that you
specify the same seed nodes in the same order on all nodes
in the cluster.
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Property Description

spectrum.cluster.nodelID Set this to an integer value to use as the ID for this node.
The ID must be an integer and must be unique among all
nodes in the cluster.

Tip: We recommend that the first node you install have a
node ID of 1, the second one 2, and so on.

spectrum. repository.server.cluster.nodeCount This property sets the number of repository nodes in the
cluster. This property must be set on nodes that run a Neo4j
instance. The way in which you specify this property
depends upon your cluster configuration:

* For cluster configurations with separate servers and
repositories: Set this flag in the
spectrum-container.properties file on each repository
node configuration, and not on the server node
configurations.

* For combined server-repository configurations: Set
the property in the spectrum-container.properties file
on each node of the cluster.

spectrum.runtime.hostname Un-comment this property and set this property to the load
balancer host name.

spectrum.runtime.port Un-comment this property and set this property to the port
on which you have configured the load balancer to listen.

spectrum.repository.addresses Set this to the same IP address specified in
spectrum.cluster.address. The default value
localhost cannot be used in a clustered environment.

If you are configuring a server node in a server-only cluster,
specify the IP addresses of the nodes in the configuration
database cluster. Separate each with a comma.

Data Hub Local Locks Strategy

Use Local Locks Strategy in a clustered environment to achieve better performance during concurrent
writes. When using this strategy you can write only to the master node; you cannot write to non-master
nodes.

Note: Scheduled backups are not supported with Local Locks Strategy.

1. Ensure the cluster is running.
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2. Open a web browser and go to the master node location for the following:

http://serverName:8080/jmx-console/HubEngineSettings MBean
3. Set UselLocalLockFactory to true. In the wrapper.log file you will see the following:

[GraphEngineSettingsManager] Switching to Local-Only locking strategy.
SERVER/CLUSTER RESTART REQUIRED.

4. Shut down all nodes in the cluster.

5. On each non-master node, add the following two properties to the <Spectrum™ Technology
Platform install path>/server/modules/hub/db/neo4j.properties file:

#Whether this instance should only participate as slave in cluster.
If set to true, it will never be elected as master.

ha.slave only=true

dbms.read only=true

6. Save the file.

7. Restart the cluster. Make sure the master node points to itself when starting the cluster backup
for the first time. After restart, you should see in the wrapper.log:

WARN [GraphEngineFactory]

Using Local-Only locking strategy. Must set read only=true in
neo4j.properties
on all servers except master.

Installing a Cluster for the Location Intelligence Module

To set up a cluster for the Location Intelligence Module, you must first configure a common repository
(depending on the type of database you have) then configure your system to prepare it for clustering.

Note: Setting up both a Spectrum™ Technology Platform cluster and a Location Intelligence
Module cluster is recommended and has several benefits:

» Security (ACL) synchronization happens automatically for named resources .
» Dataflows, users, and roles created on one node will automatically synchronize to all nodes.

+ All Location Intelligence Module demo pages and utilities (such as Spatial Manager) can
and should point to the load balancer.
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Setting Up a Common Repository Database

You must configure the Location Intelligence Module to use a common repository database for the
cluster. This ensures that named resources, geographic metadata and configuration settings are
managed across the cluster.

The repository is installed with a set of named resources, geographic metadata and configuration
files. To migrate these resources to the common database repository the resources need to be
exported from the default internal repository database and reimported into the new shared repository
database.

For bulk export and import of repository content, use the 1imrepo importand limrepo export
commands in the Administration Utility. These commands give you the option of preserving
permissions (see the Administration section of the Spectrum Spatial Guide for instructions.)

These steps describe how to set up your repository on a common database, either PostgreSQL,
Oracle, or Microsoft SQL Server:

1. Export all repository resources to a local folder using the 1imrepo export command in the
Administration Utility (see the Administration section of the Spectrum Spatial Guide for
instructions).

The contents of the installed repository must be exported. This step only needs to be performed
once, as the contents of the repository should be the same at this point for all instances of
Spectrum™ Technology Platform.

2. Stop the Spectrum™ Technology Platform server on all nodes (for instructions, see Stopping
a Cluster on page 60.)

3. Onall nodes of Spectrum™ Technology Platform modify the configuration to specify the common
database.

a) Copy the contents of repository.<databaseType>.xml to repository.xml located
under the server/modules/spatial/jackrabbit folder where <databaseType> is
the appropriate type for your database (postgres, oracle, or mssql).

b) In repository.xml:

* Modify the DataSource section with the server host name, port, database, user, and
password.

» Modify the Cluster section to assign a distinct cluster ID, like Node1. Ensure unique IDs
are assigned to every subsequent node in the cluster (for example, Node2, Node3).
» Save the changes to repository.xml.

c) Remove these folders from the /server/modules/spatial/jackrabbit folder:
repository, version, workspaces.

4. If your database has previously contained any repository content, you must remove these tables
to create a clean repository:
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default_binval
default_bundle
default_names
default_refs
rep_fsentry
rep_global_revision
rep_journal
rep_local_revisions
security_binval
security_bundle
security_names
security_refs
version_binval
version_bundle
version_names
version_refs

If using Oracle, then also delete version seq names id, security seqg names id,

and default seg names id.

5. On the seed node only, import the backed up repository content.
a) Start the Spectrum™ Technology Platform server (for instructions, see Starting a Cluster

on page 59).

b) Import the contents using the 1imrepo import command, pointing to the seed node.

6. Start the remaining nodes in the cluster (for instructions, see Starting a Cluster on page 59).

Configuring Your System

Once the Spectrum™ Technology Platform is installed and you have configured a common repository,
you need to configure your instance before you can replicate it to another virtual machine. If you
are not using a virtual machine environment, you will need to perform these steps on each of your
Spectrum™ Technology Platform installations.

Configure the Map File Share

To configure the map file share (a shared image folder) to Spectrum™ Technology Platform, you
first need a shared map image directory.

Note: To create a Unix/Linux map file share, see Creating a Map Image File Share on
Unix/Linux on page 48.

Note: To create a Windows map file share, see Creating a Map Image File Share on
Windows on page 49.

Cluster

Spectrum™ Technology Platform 2018.2.0 Installation Guide

47



Cluster

Once a map image directory has been created, configure the map file share:

1. Modify the Mapping Service configuration by pointing to a shared image folder and load balance
server. In the ImageCache change the Directory parameter to a common image directory, and
change the AccessBaseURL parameter to the load balancer machine image URL.

If you are using a virtual machine environment, remember this IP address, as you must set the
load balancer VM to this IP address.

For Unix/Linux installations:

<ImageCache>
<Directory>/<spatial server
root>/server/modules/spatial/images</Directory>
<AccessBaseURL>http://<loadbalance IP address>/rest/Spatial/
MappingService/internal/imageCache</AccessBaseURL>
<FileExpire>30</FileExpire>
<ScanInterval>30</ScanInterval>
</ImageCache>

For Windows installations:

<ImageCache>

<Directory>\\server\Share\images</Directory>
<AccessBaseURL>http://<loadbalance IP address>/rest/Spatial/MappingService/
internal/imageCache

</AccessBaseURL>

<FileExpire>30</FileExpire>

<ScanInterval>30</ScanInterval>

</ImageCache>

2. For Unix/Linux installations, you must set up a symbolic link to enable map images to go to the
shared file system.

Create an images subfolder in the mounted share folder, e.g., /mnt/<1inux mount>/images

cd /<spatial server root>/server/modules/spatial
rm —-Rf images
In -s /mnt/<linux mount>/images ./images

Creating a Map Image File Share on Unix/Linux

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a shared
folder accessible to all Spectrum nodes. The file share is not required if maps are returned from the
web services as Base64-encoded images.

To create a map image file share on Unix/Linux:

Spectrum™ Technology Platform 2018.2.0 Installation Guide 48



1. Mount a shared folder on each operating system hosting Spectrum. The commands below
mount a drive on a Microsoft Windows Server or network drive supporting CIFS.

mkdir /mnt/<linux mount>
mount -t cifs //<windows host>/<windows share> /mnt/<linux mount>-o0
username=shareuser, password=sharepassword, domain=pbi

2. Setthe image share to load at startup in /etc/fstab.

//<windows ip address for share>/share /path to/mount cifs
username=server user,password=secret, netdev 0 0

Creating a Map Image File Share on Windows

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a shared
folder accessible to all Spectrum nodes. The file share is not required if maps are returned from the
web services as Base64-encoded images.

To create a map image file share on Windows:

1. In Windows Explorer, select the image folder you want to share.
2. Right-click, then click Share or Share with.

3. Select the users who will be writing to the image folder. These users must have read/write
privileges.

Modifying OGC Service Configurations for Clustering

To ensure clustering works when you have both a Spectrum™ Technology Platform cluster and a
Location Intelligence Module cluster, changes are required to the Open Geospatial Consortium
(OGC) services configuration files using Spatial Manager: From the WFS, WMS, and WMTS settings
pages, change the online resource (service) URL to the IP address and port of the load balancer.
See the Spatial Manager Guide in the Utilities section of the Spectrum Spatial Guide for more
information.

Modifying the Java Properties Files in All Nodes

You must change the java property file in all nodes of the cluster. To modify the java properties for
Spectrum™ Technology Platform:

1. Modify the java.properties file, located in
<spectrum>/server/modules/spatial/java.properties, to point repository.host to
localhost.

2. Change the images.webapp.url and all of the service host and port numbers to point to the load
balance server.

Cluster
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Configuring Ports for Multiple Spectrum Instances

If you have multiple Spectrum™ Technology Platform instances on a single machine, you must
change the port numbers for each instance. Change all ports in <Spectrum
root>/server/app/conf/spectrum-container.properties to new port values that are
not in use. The http port reflects the port number entered in the installer.

Shared Spectrum Local Data

If you are using TAB file data on the file system, this data needs to be in a shared location accessible
by all instances of Spectrum in the load balanced environment. It is also important to note that all
named resources in the repository accessing data on the file system should point to this shared
location.

Each VM or machine hosting Spectrum needs to have access to the mounted shared drive.

Note: Using named resources that point to database tables do not require a shared drive,
as the named resources in the repository do not access the data using a file path; rather they
use a named connection to the data in the database.

Upgrading a Cluster

Prerequisites:

+ Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

* IMPORTANT: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

This procedure is for upgrading a cluster where the Spectrum™ Technology Platform server and
configuration database are installed on each node of the cluster. To upgrade a cluster, you upgrade
one node at a time. The first node you upgrade is handled slightly differently than the other nodes
because you must point the node to itself as a seed node since no other nodes will be running in
the cluster when it starts up.

Note that these scenarios have special procedures for upgrading a cluster:

For this scenario... Use this information...

...have separate clusters for server nodes and |Upgrading a Cluster with a Separated
configuration database nodes Database on page 69.
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Use this information...

...are upgrading a cluster for the Location
Intelligence Module only

Upgrading a Cluster with the Location
Intelligence Module on page 56

...are upgrading both Spectrum and Location
Intelligence Module clusters

Upgrading a Cluster with the Location
Intelligence Module on page 56

...are upgrading a cluster running the Data Hub
Module

Before shutting down all nodes, see Upgrading
a Cluster with the Data Hub Module on page
52 for some required pre-upgrade steps.

If the above scenarios do not apply to you, follow this procedure to upgrade your cluster:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

2. Stop all the nodes in the cluster. For more information, see Stopping a Cluster on page 60.
When you stop all nodes of the cluster, manually, or if all nodes are down, you must start as a
new cluster/session. To refresh, start node 1 of the cluster with spectrum.cluster.seeds IP
address as node 1’s IP alone. Do not include other nodes' IP addresses when re-starting.

3. On the last node that you stopped:

-0 o0 T

Open the file server/app/conf/spectrum-container.properties in a text editor.
Inthe spectrum.cluster. seeds property, remove all nodes except for the current node.
Make a note of the nodes you remove so you can add them back later.

Save and close spectrum-container.properties

Upgrade the node. For more information, see Upgrading a Server on page 22.

Open the file spectrum-container.properties in a text editor and configure the

cluster properties. For more information, see Cluster Properties on page 43. Be sure to
leave spectrum.cluster. seeds setto only the current node's IP address or host name.

Note: Be aware that the container property definitions are dependent upon your
server configuration and whether you are running clusters on Neo4j instances. Review
the spectrum.repository.server.cluster.nodeCount property to determine the

definitions for your setup.

4. Upgrade each of the other nodes, one at a time. Follow this procedure only when upgrading

nodes other than the first node.

Note: Be sure to back up your server before proceeding. This step is only applicable
when upgrading from Spectrum™ Technology Platform versions 11.1 or older.

a. Add or ensure that you have set these properties:

* spectrum.cluster.address — Specify the node’s IP address.
* spectrum.cluster.nodelD — Set this to "1" on the first node, and this value will

increase for subsequent nodes.
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b. Delete this folder, if present:
SpectrumLocation\server\app\repository\store\databases

c. Upgrade the node. For more information, see Upgrading a Server on page 22.

d. Open the file spectrum-container.properties in a text editor and configure the
cluster properties. For more information, see Cluster Properties on page 43. Save and
close the file when you are done.

e. Start the Server.

5. After you have upgraded and started all the nodes, go back to the first node you upgraded,
open spectrum-container.properties, and add the seed nodes you removed from
spectrum.cluster.seeds.

You may find it necessary to stop nodes manually, as in the case of applying software updates.
When you stop all nodes of the cluster manually, or if all nodes are down, you must start up as a
new cluster/session. To refresh, start node 1 of the cluster with the spectrum.cluster.seeds IP address
as node 1’s IP address only. Do not include other node's IP address at startup.

Upgrading a Cluster with the Data Hub Module

Prerequisites:

» Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

* IMPORTANT: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

In a cluster that runs the Data Hub Module, each node hosts the Spectrum™ Technology Platform
server as well as Data Hub Module models. When upgrading, you need to upgrade your models in
addition to upgrading the Spectrum™ Technology Platform server.

The upgrade process consists of these steps:

1. Back up your models and properties files.
2. On the master server, upgrade Spectrum™ Technology Platform then upgrade your models.

3. On each non-master server, upgrade Spectrum™ Technology Platform then copy the upgraded
models from the master server to the non-master server.

To upgrade a cluster that runs the Data Hub Module, follow this procedure:
1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.
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2. Open the Relationship Analysis Client and click Manage. Select the model you want to back
up then click Backup.

In addition to backing up your models, back up these two property files:

* server\modules\hub\hub.properties

* server\modules\db\neod4j.properties

3. Identify which node is the serving as the master server for the Data Hub Module.
a) Open a web browser and go to:

http://LoadBalancer:8080/jmx-console/HttpAdaptor/list

b) Scroll down to the neo4j.org domain.

You will see a set of objects for each model. The Role attribute in the HighAvailability
object indicates whether a server is the master for a model.

c) If you have more than one model and each model has a different master, you need to make
one server the master of all the models. To do this, restart the cluster then open the
Relationship Analysis Client using the hostname or IP address of one of the nodes rather
than the load balancer. In the Relationship Analysis Client, open each model by running a
query on each model. This will make the server you are connected to the master for each
model.

4. Stop each non-master node in the cluster; stop the master server last. Stop nodes one at a time
rather than all at once.

Important: Make sure that Spectrum™ Technology Platform stops without errors. If a server
does not stop properly, Data Hub Module models on the server will not open successfully after
upgrading. To ensure that Spectrum™ Technology Platform stopped cleanly, examine the
SpectrumDirectory\server\app\repository\logs\wrapper.logfile forerrors during
shutdown.

5. Upgrade the master server.

a) Ifyou are upgrading from Spectrum™ Technology Platform 11.0 or later, each model directory
must contain a version.data file. Review all the model . Mode 1 Name subdirectories
located under Spectrumbirectory/server/modules/hub/db to confirm that they
contain a version.data file. If any model directory is missing this file, copy the
corresponding version.data file from one of the non-master nodes.

b) Important: The installer will prompt you to start Spectrum™ Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

Run the Spectrum™ Technology Platform installer to upgrade the master server to the new
version of Spectrum™ Technology Platform.
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c) Openthefile SpectrumFolder\server\modules\hub\hub.properties in an editor
and confirm that the property hub.neo4j.database. type is set to embedded:

hub.neo4j.database.type=embedded

d) Open the file SpectrumFolder\server\modules\hub\db\neo4j.propertiesin
an editor and set the dbms.allow format migration property to true:

dbms.allow format migration=true

e) Start the Spectrum™ Technology Platform server.

f)  Open each model in the Relationship Analysis Client and run a query. Any query is sufficient.

g) Stop the Spectrum™ Technology Platform server.

h) Indexed properties are now restricted to a maximum length of 4039 bytes. If your model
has an indexed property that exceeds this limitation, proceed to Step 6. If your model does
not have an indexed property that exceeds this limitation, continue with substep i below.

i) Openthe SpectrumFolder\server\modules\hub\hub.properties fileinan editor
and set the property hub.neo47j.database. type to ha:

hub.neo4j.database.type=ha

j)  Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

k) Skip Step 6 and continue to Step 7.

6. Indexed properties are now restricted to a maximum length of 4039 bytes. If a model has an
indexed property that exceeds this limitation, you will not be able to open that model until you
complete the following steps:

a) Copy the Spectrum\server\modules\hub\db\neo4j.properties file to the
Spectrum\server\modules\hub\db\model .modelName folder for each model that
exceeds the property constraint of 4039 characters.

b) Open the neodj.properties files that you copied in Step a. In a text editor, uncomment and
set doms.index.default schema provider to lucene+native-1.0. Make sure
the neo4j store upgrade is uncommented and that dbms.allow format migrationis
setto true.

c) Start the Spectrum™ Technology Platform server.

d) Remove the
Spectrum\server\modules\hub\db\model.modelName\neo4j.properties file
or files. By removing the files, version 2.0 of Lucene indexing will now be used by default.
We recommend that you fix all models that failed upgrade due to the 4039 indexed property
constraint and re-index those models to the latest lucene 2.0 indexes. See the hub model
reindex command in the Adminstration Utility section of the Administration Guide.

e) Stop the Spectrum™ Technology Platform server.

Cluster
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f) Openthe SpectrumFolder\server\modules\hub\hub.properties file in an editor
and set the property hub.neo47j.database. type to ha:

hub.neo4j.database.type=ha

g) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

7. Upgrade the non-master servers.
a) Delete the models in the SpectrumbDirectory\server\modules\hub\db directory.

Warning: Do not delete the models from the master server.

b) Important: The installer will prompt you to start Spectrum™ Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

On one of the non-master servers, run the Spectrum™ Technology Platform installer to
upgrade it to the new version of Spectrum™ Technology Platform.

c) Openthe SpectrumFolder\server\modules\hub\hub.properties filein an editor
and confirm that the property hub.neo4j.database. type is set to embedded:

hub.neod]j.database.type=embedded

d) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

e) Copy the SpectrumFolder\server\modules\hub\db\model. * directories from the
master server to the non-master server.

f) Repeat these steps for each non-master server in the cluster.

8. Start the cluster.

a) Start the master server, followed by non-master servers.
b) Ensure that each server in the cluster is functioning. Check
SpectrumFolder\server\app\repository\wrapper.log for any errors.

c) While directly connected to the master server (bypassing the load balancer), open each
model, one at a time, and inspect the wrapper. 1og file for errors.
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Upgrading a Cluster with the Location Intelligence Module

When a common repository database is used for clustering, these additional steps are required
before and after the Spectrum™ Technology Platform upgrade process. This upgrade process must
be followed even if you have a single node with a common repository database.

Before the upgrade, you must move to a local database setup; after the upgrade, you then change
back to the cluster setup by pointing repository.xml to the external database.

Note: To preserve access control settings, use the Administration Utility instead of WebDAV.
See the Administration section of the Spectrum Spatial Guide for instructions on using the
Administration Utility. The 1imrepo commands in the Administration Utility were available
beginning in version 11.0; if you are upgrading from a version prior to 11.0, you must use
WebDAV.

1. Before upgrading Spectrum™ Technology Platform, back up the repository by following these
steps.
a) Selectanode from the cluster. This will be the seed node (see Installing a Cluster on page
38).
b) Back up the repository content using the Administration Utility's 1 imrepo export command
with ACL, pointing to the seed node.

c) Back up the spectrum\server\modules\spatial\jackrabbit folder to a location
outside the installation folder.

2. Switch the common repository database to a local database (temporarily, just for upgrade
purposes). Apply these steps to all nodes in the cluster.

a) Stop the Spectrum™ Technology Platform server on all nodes (for instructions, see Stopping
a Cluster on page 60).

b) Delete the repository, version, workspaces folders and the 1ock.properties file (if
available) from the jackrabbit folder
(Spectrum\server\modules\spatiall\jackrabbit).

c) Copy the contents of repository.standalone.xml to repository.xml.

d) Startthe Spectrum™ Technology Platform server on all nodes (for instructions, see Starting
a Cluster on page 59).

e) Import the repository content (backed up in Step 1b) into the repository using the 1imrepo
import command with ACL for all nodes.

f)  Stop the Spectrum™ Technology Platform server.
3. Follow normal procedures in Upgrading a Cluster on page 50 to upgrade Spectrum™
Technology Platform to the new version on all nodes.

4. For the seed node only, after the Spectrum™ Technology Platform upgrade is complete, back
up the upgraded content by following these steps.
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a) Startthe upgraded Spectrum™ Technology Platform server on the seed node and download
the Administration Utility.

b) Back up the content from the repository using the 1imrepo export command with ACL
by pointing to the seed node.

c) Stop the Spectrum™ Technology Platform server on all nodes (for instructions, see Stopping
a Cluster on page 60).

d) Onallnodes, back up the upgraded Spectrum\server\modules\spatial\jackrabbit
folder to a location outside the installation folder.

5. On all nodes of Spectrum™ Technology Platform modify the configuration to specify the common
database.

a) Copythe contents of repository.<databaseType>.xml to repository.xml located
under the server/modules/spatial/jackrabbit folder where <databaseType> is
the appropriate type for your database (postgres, oracle, or mssql).

b) In repository.xml:

» Modify the DataSource section with the server host name, port, database, user, and
password.

» Modify the Cluster section to assign a distinct cluster ID, like Node1. Ensure unique IDs
are assigned to every subsequent node in the cluster (for example, Node2, Node3).

» Save the changes to repository.xml.

c) Remove these folders from the /server/modules/spatial/jackrabbit folder:
repository, version, workspaces.

6. If your database has previously contained any repository content, you must remove these tables
to create a clean repository:

* default_binval

* default_bundle
 default_names

* default_refs

* rep_fsentry

* rep_global_revision
* rep_journal

* rep_local_revisions
* security_binval

* security_bundle

* security_names

* security_refs

* version_binval

* version_bundle

* version_names

* version_refs

Cluster
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If using Oracle, then also delete version seq names id, security seg names id,
and default seq names id.
7. On the seed node only, import the backed up repository content.

a) Start the Spectrum™ Technology Platform server (for instructions, see Starting a Cluster
on page 59).
b) Import the contents using the 1imrepo import command, pointing to the seed node.

8. Start the remaining nodes in the cluster (for instructions, see Starting a Cluster on page 59).

Removing a Node from a Cluster

To remove a node from a cluster, stop the Spectrum™ Technology Platform server.

1. To stop the server, right-click the Spectrum™ Technology Platform icon in the Windows system
tray (shown below) and select Stop Spectrum™.

2. Stop the node you want to remove:
change the working directory to the Spectrum™ Technology Platform server's bin directory,
source the setup file, then type the following command: . /server.stop.

On Windows, right-click the Spectrum™ Technology Platform icon in the system tray and select
Stop Spectrum™.

3. Open the file server/app/conf/spectrum-container.properties in a text editor and
set spectrum.cluster.enabled to false.

4. On each of the other nodes in the cluster, open the spectrum-container.properties file
and remove the node from the spectrum.cluster.seeds property.

For Location Intelligence Module users: If you want to keep the node standalone and able to run
outside the cluster, copy back the original repository.xml file and remove the following folders
from the /server/modules/spatial/jackrabbit directory for each instance of Spectrum™
Technology Platform: repository, version, workspaces. Restart the server and import the repository
content.

Adding Modules to a Cluster

This procedure describes how to add one or more modules to an existing cluster.

1. Stop all the Spectrum™ Technology Platform nodes in the cluster. For more information, see
Stopping a Cluster on page 60. If your cluster has a separated configuration database cluster,
you only need to stop the server cluster, not the configuration database cluster.
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Warning: To prevent data loss you must stop the cluster by following the procedure described
in Stopping a Cluster on page 60.

On any node in the cluster, install the module or modules you want to add.
Open this file in a text editor:

server/app/conf/spectrum-container.properties

Inthe spectrum.cluster. seeds property, remove all host names and IP addresses except
for the one for this server. Save the host names and IP addresses so that you can re-add them
later.

Save the file.
Start the server.

Note: Wait for the server to fully start before proceeding.

In the file spectrum-container.properties, add the host names and IP addresses that
you had removed.

Save the file. You do not need to restart the server.

Install the modules on each of the other nodes in the cluster. Start each node after installing
the modules on it, and wait for it to fully start before installing the modules on the next node.
You do not need to modify the spectrum.cluster.seeds property when installing modules
on subsequent nodes.

Starting a Cluster

If all the nodes in a cluster are stopped, you must follow this procedure to start the cluster safely
and avoid data loss.

1.

On the last node that was stopped last, remove the seed nodes and start the server.

Warning: The first node that you start must be the last node that was stopped, and that node
must be a seed node. Starting another node first may result in loss of data such as job history
and configuration settings. If you do not know which node was stopped last, look in each node's
wrapper log for the time stamp of the shutdown message. You can find the wrapper log in:
Spectrum Location\server\app\repository\logs\wrapper.log.

a) Open this file in a text editor:

server/app/conf/spectrum-container.properties

b) Inthe spectrum.cluster.seeds property, remove all host names and IP addresses
except for the one for this server. Save the host names and IP addresses so that you can
re-add them later.

Cluster
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c) Save the file.
d) Start the server.
e) Wait for the Spectrum™ Technology Platform server to completely start.

You can tell when the Spectrum™ Technology Platform server has completely started by
looking in the wrapper log: Spectrum
Location\server\app\repository\logs\wrapper.log. This message is displayed
when the server is completely started:

Pitney Bowes Spectrum(TM) Technology Platform (Version Version
Number) Started.

f) In the properties file spectrum-container.properties, in the
spectrum.cluster.seeds property, add the host names or IP addresses that you had
removed, separating each with a comma.

g) Save and close the file. You do not need to restart the server.

Start the other nodes in the cluster.

Warning: Be sure to wait for the first node to start completely before starting additional nodes.
Starting additional nodes before the first one is started may result in loss of data.

Stopping a Cluster

To stop an entire cluster:

1.

Identify which nodes are seed nodes. To do this, open the file
SpectrumFolder/server/app/conf/spectrum-container.properties and look at
the nodes listed in the spectrum.cluser.seeds property.

Stop each Spectrum™ Technology Platform server in the cluster, making sure that the last node
you stop is a seed node.

Right-click the Spectrum™ Technology Platform icon in the Windows system tray and select
Stop Spectrum™.

Warning: To prevent loss of data when starting the cluster, the first node you start must be the
last node that was stopped, and that node must be a seed node.

Cluster
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Using Enterprise Designer with a Cluster

1. Launch Enterprise Designer.
2. In the Server name field, enter the server name of the load balancer.
3. Inthe Port field, enter the port that you have configured the load balancer to listen on.

Note: Input files, output files and database resources must be on a shared drive, or file
server, or some commonly-accessible location. Otherwise, all files must be loaded on
each server that hosts a Spectrum™ Technology Platform server and must be located in
the same path.

Once you have logged in you can use Enterprise Designer as normal. The actions you take will
apply to all Spectrum™ Technology Platform instances in the cluster where you are logged in.

Disabling Host Checks in Token Authentication

In token authentication, the Spectrum™ Technology Platform server examines the token presented
by the client before responding to the request. The server checks the token to see if it has expired,
if it is encrypted correctly, and if it is from the correct host. For session tokens, the server also checks
the session ID. If any of these checks fail, the token is rejected and the server does not respond to
the request.

In a clustered environment, it is possible that requests may be redirected in a way that makes the
request appear to be coming from a different host than is specified in the token, resulting in "invalid
token" errors. For example, say you have a cluster with two nodes as shown here:

Mode 1: Requests are
from host 2.2 2 2

% Load Balancer

Client 2222 = > 3
1111 % 3
. =
Proxy or VM Adapter Mode 2: Requests are
3333 from host 3.3.3.3
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Let's say that the client makes a request and is the request is routed to Node 1. A token is created
and tied to host 2.2.2.2 (the load balancer) since the node views the request as coming from the
load balancer. If the next request from the client is routed to Node 2, the token will still be tied to
host 2.2.2.2 but the request will appear to be coming from the proxy server, 3.3.3.3. In this case the
node will reject the token because it appears that it is not associated with the host making the
request.

In this situation you must configure the Spectrum™ Technology Platform server to ignore the host
information included in the token. This should only be done if you have an environment where there
are different network devices between the load balancer and the nodes. If all nodes are behind the
same network device, there is no need to disable the host check.

Note: If you follow this procedure, client tokens become "open" tokens, since the host check
is disabled. Session tokens will continue to be associated with a specific session ID, but not
with a specific host.

1. Open the following properties file on the Spectrum™ Technology Platform server:

SpectrumLocation/server/app/conf/spectrum-container.properties
2. Set the following property to false.

spectrum.security.authentication.token.remoteClientCheck.enabled=false

3. Save and close the properties file.
4. Repeat this process on all the nodes in the cluster.
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Cluster with Separated Configuration Database

Installing a Cluster with a Separated Configuration
Database

This procedure creates two clusters: one for the server nodes and one for configuration database

nodes. The nodes in the server cluster point to the servers in the configuration database cluster for
their configuration data. The nodes in the configuration database cluster replicate their data between
each other.

The following diagram illustrates this installation scenario:

Requests
{Such as API calls, web service requests, clients)

Server Cluster ‘
Load Balancer
’;@
\ 5
—_— [ i
i
v v y v A\ 4 -
External Resources
'Spectrum Node 1 Spectrum Node 2 ISpectrum Node 3 ISpectrum Node 4 Spectrum Node 5 (Database resource,
file servers, etc.)
& 4 & &

Configuration Database Cluster

A4 ‘L v

Configuration Server 1 Configuration Server 2 Configuration Server 3

Configuration Database Configuration Database Configuration Database

To install a separate database repository, you first install the configuration database on servers in
a cluster, then install the server on nodes in a separate cluster. At least one configuration database
must be running before you can install the server.

Note: In the case of a separated database configuration cluster setup, as shown here, you
can apply load balancing only to the Spectrum server cluster. You cannot apply load balancing
to the separated database cluster.

1. Place the Spectrum™ Technology Platform installer on the server where you want to install the
configuration database.

2. Runinstalldb. sh.
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Double-click installdb.exe.
Follow the prompts to install the configuration database.

Important: When prompted with the option to start Spectrum™ Technology Platform after the
installation, you must disable this option so that the database does not start automatically when
the installation completes.

Edit the file Database/repository/spectrum-container.properties as described in
Cluster Properties for a Configuration Database Cluster on page 68.

Save and close spectrum-container.properties.

Start the configuration database. To start the configuration database, right-click the Spectrum™
Technology Platform icon in the Windows system tray and select Start Spectrum™. Alternatively,
you can use the Windows Services control panel to start the configuration database by starting
the Spectrum Database service.

Install the configuration database on additional servers as needed to complete the configuration
database cluster.

Install the server cluster.

a) Install Spectrum™ Technology Platform on a server where you want to host a node. For
instructions, see Installing a New Server on page 21.

Important: When installing each server select the Server only option in the installer and
provide the host and port of one or more of the configuration database servers. You can
find the port in the file
InstallationLocation\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

b) Ifthe Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows system tray and select Stop
Spectrum™.

c) Edit the properties in file server/app/conf/spectrum-container.properties, as
described in Cluster Properties on page 43.

d) Save and close the spectrum-container.properties file.

e) Some modules have module-specific settings that you must configure to enable the module
to work in a cluster.
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Cluster Configuration Settings

Advanced Matching Module

These settings configure clustering for full-text search indexes. If
you do not use full-text search indexes you do not need to

configure these settings.

Open this file in a text editor:

SpectrumFolder\server\modules\searchindex\

es—-container.properties
Configure these properties:

es.index.default_number_of_replicas

es.index.default_number_of_shards

Enter the number of additional
copies you want created for
each search index. This
number should be the number
of nodes in your cluster minus
1. For example, if your cluster
has five nodes, you would
enter "4" in this property.

Enter the number of shards
you want your index to have in
the distributed environment.
The more nodes that are in
your cluster, the higher this
number should be.

Save and close
es-container.properties
when you are done editing
these properties.

Note: Search indexes created prior Spectrum™
Technology Platform 10.0 do not support clustering. To
enable clustering for indexes created prior to the 10.0
release, you must recreate the search index using the

10.0 API after modifying the
es-container.properties

file.
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Module Cluster Configuration Settings

Data Hub Module Open this file in a text editor:
SpectrumFolder\server\modules\hub\hub.properties
Configure these properties:

hub.models.path.base Specifies the folder where models are
stored. By default, each model is
placed in a subdirectory under the
SpectrumFolder\server\modules
\hub\db folder. If you want to store
models in a different location,
uncomment this property and specify
the folder where you want to store
models.

hub.neodj.database.type Change the value of this property to
ha. The default value embedded is for
non-clustered installations.

hub.servers.per.cluster Uncomment this line. Set the value of
this property to the number of
Spectrum™ Technology Platform
servers in the cluster.

Save and close hub . properties when you are done editing
these properties.

The SpectrumFolder\server\modules\hub\
db\neo4j.properties controls how the graph databases are
configured, using Neo4j Enterprise. This file is used as a template
for each model. If needed, each model can be configured
separately by placing a copy of this property file into the store
directory for that model.

f) Start the server. To start the server, right-click the Spectrum™ Technology Platform icon in
the Windows task bar and select Start Server.
g) Repeat this procedure to install additional nodes in the server cluster.

10. After installing all the nodes in the server cluster, go back to the first node you installed in the

server cluster and add the other nodes as seed nodes.

a) On the first node you installed, open the properties file
server/app/conf/spectrum-container.properties.

b) Inthe property spectrum.cluster. seeds, add the host name or IP address of the other
nodes in the cluster, separating each with a comma.

c) Save and close the spectrum-container.properties file. You do not need to restart
the server.
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Cluster Properties for a Configuration Database Cluster

A configuration database cluster is a cluster where each node contains the configuration database
only, and not the server. If you are setting up a cluster where the server and configuration database
are installed together on each node, or are setting up a server-only cluster, see Cluster Properties
on page 43.

The settings for a configuration database cluster are located in this properties file:
Database\repository\spectrum-container.properties

This table describes each property:

Property Description
spectrum.cluster.enabled Set this to true.
spectrum.cluster.name If this is the first node in the cluster, set this to any name

you want to give to the configuration database cluster. Be
sure that the name is unique if you have multiple clusters.

If you are adding a node to an existing cluster, set this to
the name of the configuration database cluster that you want
this node to join.

spectrum.cluster.address Specify the node's own IP address.
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Property Description

spectrum.cluster.seeds If you are setting up the first node in the cluster, or if this is
the first node you are starting after having stopped the
cluster, specify only the host name or IP address of this
server. This effectively points this node to itself as a seed
node, which is necessary in order for it to be able to start
as the first node in the cluster.

If this is not the first node in the cluster, use the host name
or IP address of the Spectrum™ Technology Platform server
whose configuration will be replicated on this node when it
joins the cluster, resulting in synchronized configuration.
You can specify multiple seed nodes by separating each
with a comma. When starting up, the node will attempt to
access each seed node in the order listed. If none of the
seed nodes can be reached, the node will not join the
cluster.

Tip: We recommend that you specify multiple seed nodes
so that if one seed node is down others can be used to allow
nodes to join the cluster. We also recommend that you
specify the same seed nodes in the same order on all nodes
in the cluster.

spectrum.cluster.nodelD Set this to an integer value to use as the ID for this node.
The ID must be an integer and must be unique among all
nodes in the database cluster. For example, you could set
the node ID for the first node to 1, the second node's node
ID to 2, and the third node's node ID to 3.

Upgrading a Cluster with a Separated Database

Prerequisites:

» Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

* IMPORTANT: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

This procedure describes how to upgrade Spectrum™ Technology Platform when you have separated
the configuration database from the server. To upgrade an environment that has a separated
configuration database, you first upgrade the configuration database cluster, then the server cluster.
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Back up the server. For instructions on creating a backup, see the Administration Guide.

Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

Back up module-specific data for any of these modules if you have them installed.

Module Items to Back Up
Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumLocation/server/modules:
* cdgdb
* lucene

» matcher

* parser

*« searchindex
*+ tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

» server\modules\hub\hub.properties
» server\modules\db\neod]j.properties

Location Intelligence Module Back up your named resources, data, and configuration
files.

Stop all the nodes in the server cluster then stop all the nodes in the configuration database
cluster. Make a note of the last node that you stop in the configuration database cluster. You
must start this node first after upgrading. For instructions on stopping a cluster, see Stopping
a Cluster on page 60.

On the last node that you shut down in the configuration database cluster, run installdb.exe.
The installer upgrades the configuration database.

Warning: The first node that you upgrade must be the last node that was stopped. This is
because on some operating systems the configuration database will start automatically at the
end of the upgrade process. If the first node that starts is not the last node that was stopped,
data such as job history and configuration settings may be lost. If you do not know which node
was stopped last, look in each node's wrapper log for the time stamp of the shutdown message.
You can find the wrapper log in: Spectrum
Location\Database\repository\logs\wrapper.log.
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Important: When prompted with the option to start Spectrum™ Technology Platform after the
installation, you must disable this option so that the database does not start automatically when
the installation completes.

5. After the upgrade is complete, the configuration database starts up automatically. Verify that
the configuration database is fully started before continuing by opening the log file
SpectrumInstallationLocation\Database\repository\logs\wrapper.log and
looking for the message Started.

6. Stop the configuration repository.

Right-click the Spectrum™ Technology Platform icon in the Windows system tray and select
Stop Spectrum™. Alternatively, you can use the Windows Services control panel to stop the
configuration database by stopping the Spectrum Database service.

Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

7. Configure clustering for the database cluster.

a) Editthefile Database/repository/spectrum-container.properties asdescribed
in Cluster Properties for a Configuration Database Cluster on page 68.

b) Save and close the spectrum-container.properties file.

c) Start the last node that was stopped in the configuration database cluster. To start the
configuration database, right-click the Spectrum™ Technology Platform icon in the Windows
system tray and select Start Spectrum™. Alternatively, you can use the Windows Services
control panel to start the configuration database by starting the Spectrum Database service.

d) To start the configuration database, right-click the Spectrum™ Technology Platform icon in
the Windows system tray and select Start Spectrum™. Alternatively, you can use the
Windows Services control panel to start the configuration database by starting the Spectrum
Database service.

e) After the upgraded configuration database is fully started, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start each
of them.

8. Upgrade each node in the server cluster. For more information, see Upgrading a Cluster on
page 50.

Important: When installing each server select the Server only option in the installer and provide
the host and port of one or more of the configuration database servers. You can find the port
in the file
InstallationLocation\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

Note: Any job or subflow stored in the system during a server upgrade is marked as exposed
to provide the same behavior for those jobs and subflows as before the upgrade. Any job or
subflow that is exported prior to the upgrade will not be exposed. Therefore, when importing
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these jobs or subflows back into the system, you must manually expose the imported job or
subflow.

Some modules have post-upgrade steps you need to perform.

Data Hub Module Open this file in a text editor:
server/modules/hub/neo4j.properties
and set the property
dbms.allow format migration property to
true. The purpose of this property is to protect against
unintentional and irreversible store upgrades. Setting this
property to "true" indicates that you understand the
ramifications of proceeding with an upgrade and have taken
the necessary precautions before proceeding.

Restart the Spectrum™ Technology Platform server. The
server will upgrade each model. Examine the file
server/app/repository/logs/wrapper.log
for errors or warning messages. Once all models have been
upgraded, go back to the hub .properties file and

commentoutthe allow store upgrade property.

Upgrading a Cluster with a Separated Database and Data
Hub Module

Prerequisites:

» Before upgrading, be sure to read the release notes for the new version. The release notes contain
a list of known issues, important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

» Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

* IMPORTANT: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

This procedure describes how to upgrade Spectrum™ Technology Platform when you have separated
the configuration database from the server and you have the Data Hub Module installed. The upgrade
process consists of these steps:

1. Stop the server cluster.
2. Stop the configuration database cluster.
3. Upgrade the last node that was stopped in the configuration database cluster.
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4. Upgrade the other nodes in the configuration database cluster.
5. Upgrade the server acting as the Data Hub Module master in the server cluster.
6. Upgrade the non-master servers in the server cluster.

To upgrade a cluster with a separated configuration database and the Data Hub Module, follow this
procedure:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important: We recommend that you create a backup before upgrading so that you can recover
your flows, security settings, and other settings, if an error occurs during the upgrade process.

2. Open the Relationship Analysis Client and click Manage. Select the model you want to back
up then click Backup.

In addition to backing up your models, back up these two property files:

* server\modules\hub\hub.properties

* server\modules\db\neodj.properties

3. Identify which node is the serving as the master server for the Data Hub Module.
a) Open a web browser and go to:

http://LoadBalancer:8080/jmx-console/HttpAdaptor/list

b) Scroll down to the neo4j.org domain.

You will see a set of objects for each model. The Role attribute in the HighAvailability
object indicates whether a server is the master for a model.

c) Ifyou have more than one model and each model has a different master, you need to make
one server the master of all the models. To do this, restart the cluster then open the
Relationship Analysis Client using the hostname or IP address of one of the nodes rather
than the load balancer. In the Relationship Analysis Client, open each model by running a
query on each model. This will make the server you are connected to the master for each
model.

4. Stop all the non-master nodes in the server cluster then stop the master server last. Stop nodes
one at a time rather than all at once.

Important: Make sure that Spectrum™ Technology Platform stops without errors. If a server
does not stop properly, Data Hub Module models on the server will not open successfully after
upgrading. To ensure that Spectrum™ Technology Platform stopped cleanly, examine the
SpectrumDirectory\server\app\repository\logs\wrapper.logfile forerrors during
shutdown.

5. Stop all the nodes in the configuration database cluster. Make a note of the last node that you
stop in the configuration database cluster. You must start this node first after upgrading.

6. On the /ast node that you shut down in the configuration database cluster, execute
installdb.exe. The installer upgrades the configuration database.
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Warning: The first node that you upgrade must be the last node that was stopped. This is
because on some operating systems the configuration database will start automatically at the
end of the upgrade process. If the first node that starts is not the last node that was stopped,
data such as job history and configuration settings may be lost. If you do not know which node
was stopped last, look in each node's wrapper log for the time stamp of the shutdown message.
You can find the wrapper log in: Spectrum
Location\server\app\repository\logs\wrapper.log.

7. After the upgrade process finishes, wait for the server to start, then stop the server.

You can see when the server has started up by opening the log file <Spectrum Installation
Location>\server\app\repository\logs\wrapper.log and looking forthis message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform Database
(Version version build) Started

Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

8. Configure clustering for the database cluster.

a) Editthe file server/app/conf/spectrum-container.properties as described in
Cluster Properties for a Configuration Database Cluster on page 68.

b) Save and close the spectrum-container.properties file.

c) Startthe last node that was stopped in the configuration database. To start the configuration
database, right-click the Spectrum™ Technology Platform icon in the Windows system tray
and select Start Spectrum™. Alternatively, you can use the Windows Services control panel
to start the configuration database by starting the Spectrum Database service.

Warning: The first node that you start must be the last node that was stopped, and that
node must be a seed node. Starting another node first may result in loss of data such as
job history and configuration settings. If you do not know which node was stopped last, look
in each node's wrapper log for the time stamp of the shutdown message. You can find the
wrapperlogin: Spectrum Location\server\app\repository\logs\wrapper.log.

d) After the upgraded configuration database is fully started, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start each
of them.

9. Upgrade the Data Hub Module master server in the server cluster.

a) Ifyou are upgrading from Spectrum™ Technology Platform 11.0 or later, each model directory
must contain a version.data file. Review all the model . Mode 1 Name subdirectories
located under Spectrumbirectory/server/modules/hub/db to confirm that they
contain a version.data file. If any model directory is missing this file, copy the
corresponding version.data file from one of the non-master nodes.
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b) Important: The installer will prompt you to start Spectrum™ Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

Run the Spectrum™ Technology Platform installer to upgrade the master server to the new
version of Spectrum™ Technology Platform.

c) Openthefile SpectrumFolder\server\modules\hub\hub.properties in an editor
and confirm that the property hub.neo47.database. type is set to embedded:

hub.neod4j.database.type=embedded

d) Open the file SpectrumFolder\server\modules\hub\db\neodj.propertiesin
an editor and set the dbms.allow format migration property to true:

dbms.allow format migration=true

e) Start the Spectrum™ Technology Platform server.

f) Open each model in the Relationship Analysis Client and run a query. Any query is sufficient.

g) Stop the Spectrum™ Technology Platform server.

h) Indexed properties are now restricted to a maximum length of 4039 bytes. If your model
has an indexed property that exceeds this limitation, proceed to Step 6. If your model does
not have an indexed property that exceeds this limitation, continue with substep i below.

i) Openthe SpectrumFolder\server\modules\hub\hub.properties fileinan editor
and set the property hub.neo4j.database. type to ha:

hub.neodj.database.type=ha

i) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

k) Skip Step 6 and continue to Step 7.

Upgrade the Data Hub Module non-master servers in the server cluster.

Important: When installing each server select the Server only option in the installer and provide
the host and port of one or more of the configuration database servers. You can find the port
in the file
InstallationLocation\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

a) Delete the models in the SpectrumDirectory\server\modules\hub\db directory.
Warning: Do not delete the models from the master server.

b) Important: The installer will prompt you to start Spectrum™ Technology Platform after the
installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

Spectrum™
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On one of the non-master servers, run the Spectrum™ Technology Platform installer to
upgrade it to the new version of Spectrum™ Technology Platform.

c) Openthe SpectrumFolder\server\modules\hub\hub.properties filein an editor
and confirm that the property hub.neo4j.database. type is set to embedded:

hub.neo4j.database.type=embedded

d) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

e) Copy the spectrumFolder\server\modules\hub\db\model.* directories from the
master server to the non-master server.

f) Repeat these steps for each non-master server in the cluster.

11. Start the cluster.

a) Start the master server, followed by non-master servers.
b) Ensure that each server in the cluster is functioning. Check
SpectrumFolder\server\app\repository\wrapper.log for any errors.

c) While directly connected to the master server (bypassing the load balancer), open each
model, one at a time, and inspect the wrapper . 1og file for errors.

Converting to a Separated Configuration Database

Converting an existing Spectrum™ Technology Platform installation to a separated configuration
database enables you to take advantage of the improved scalability of a separated configuration
database. When you convert to a separated configuration database, your existing installation is
converted from one where the configuration database is part of the server to one where the
configuration database is in a separate cluster.

At a high level, this is the conversion process:

« Stop your existing Spectrum™ Technology Platform server.
» Set up the new configuration database cluster:

* Install the separate configuration database software on a new server.
» Copy your existing configuration database to the new server.
» Configure clustering and start the configuration database cluster.

* Install the server-only cluster and start it up.

Note: This procedure applies both to converting a single server to a separated configuration
database, and converting a cluster to a separated configuration database.

To convert to a separated configuration database:
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1. Back up module-specific data for any of these modules if you have them installed.

Module Items to Back Up

Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in

and Universal Name Module SpectrumLocation/server/modules:

cdgdb
lucene
matcher
parser
searchindex
tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two

property files:

+ server\modules\hub\hub.properties
+ server\modules\db\neodj.properties

Location Intelligence Module Back up your named resources, data, and configuration

files.

2. Ifthe server you are converting is running Spectrum™ Technology Platform 11.0 SP1 or earlier,
you must upgrade to the latest version of Spectrum™ Technology Platform before converting
from a standard installation to a separated configuration database. For more information, see
Upgrading a Server on page 22 (for upgrading a single server) or Upgrading a Cluster on

page 50 (for upgrading a cluster).

3. Stop the server. If you have a clustered installation, stop the cluster.
4. Install the configuration database to a new server.

a) Place the Spectrum™ Technology Platform installer on the machine where you want to
install the configuration database. This must be a different machine from the one where

you have your existing Spectrum™ Technology Platform server installed.

b) Double-click installdb.exe.

c) Follow the prompts to install the configuration database.

Important: When prompted with the option to start Spectrum™ Technology Platform after
the installation, you must disable this option so that the database does not start automatically

when the installation completes.
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d) Copythe Database\repository\data\databases folder from your existing server to
the server where you installed the separate configuration database. Replace the existing
folder.

e) Configure the cluster properties for the database cluster by editing the file
Database\repository\spectrum-container.properties asdescribedin Cluster
Properties for a Configuration Database Cluster on page 68.

f) Save and close the spectrum-container.properties file.

g) Start the configuration database. To start the configuration database, right-click the
Spectrum™ Technology Platform icon in the Windows system tray and select Start
Spectrum™. Alternatively, you can use the Windows Services control panel to start the
configuration database by starting the Spectrum Database service.

h) Install the configuration database on additional servers as needed to complete the
configuration database cluster.

5. Install the server.

a) (Optional) If you are upgrading to a new version and you want to use the same machine to
host the upgraded server as hosted the existing server, uninstall the existing server of
Spectrum™ Technology Platform.

b) Install the server cluster. For more information, see Installing a Cluster on page 38.

Important: When installing each server select the Server only option in the installer and
provide the host and port of one or more of the configuration database servers. You can
find the port in the file
InstallationLocation\Database\repository\spectrum-container.properties.
The port is specified in the spectrum.repository.server.connector.bolt.port
property.

Converting from a Separated Configuration Database to
a Standard Installation

If you have a cluster that consists of separate clusters for the server and for the configuration
database, you can convert your installation to a standard installation where the server and
configuration database are installed together on the same server.

1. Back up module-specific data for any of these modules if you have them installed.
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Module Items to Back Up
Advanced Matching Module, Data Normalization Module, Back up the contents of these subfolders located in
and Universal Name Module SpectrumLocation/server/modules:
» cdgdb
« Jucene

» matcher

* parser

« searchindex
« tables

Data Hub Module Open the Relationship Analysis Client and click Manage.
Select the model you want to back up then click Backup.

In addition to backing up your models, back up these two
property files:

« server\modules\hub\hub.properties
+ server\modules\db\neod]j.properties

Location Intelligence Module Back up your named resources, data, and configuration
files.

Stop all the nodes in the server cluster, then stop all the nodes in the configuration database
cluster.

The configuration database must be of the same version of Spectrum™ Technology Platform
as the server you are converting to. If the configuration database is from an older version,
upgrade the configuration database to the same version of Spectrum™ Technology Platform
as the version you want to use for the standard server. The installer upgrades the configuration
database.

Warning: The node that you upgrade must be the last node that was stopped. This is so that
data such as job history and configuration settings are not lost. If you do not know which node
was shut down last, look in each node's wrapper log for the time stamp of the shutdown message.
You can find the wrapper log in: Spectrum
Location\server\app\repository\logs\wrapper.log.

After the upgrade process finishes, wait for the server to start, then stop the server.

You can see when the server has started up by opening the log file
SpectrumInstallationLocation\Database\repository\logs\wrapper.log and
looking for the message Started.
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Important: Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

5. Install a new server.
For instructions, see Installing a New Server

Note: When prompted, be sure to select Standard Installation, not Server only.

6. Stop the server.

7. Copy the SpectrumLocation\Database\repository\data\databases folder from the
last configuration database server you stopped to the new server, replacing the existing folder.

8. Start the server.

Adding Modules to a Cluster

This procedure describes how to add one or more modules to an existing cluster.

1. Stop all the Spectrum™ Technology Platform nodes in the cluster. For more information, see
Stopping a Cluster on page 60. If your cluster has a separated configuration database cluster,
you only need to stop the server cluster, not the configuration database cluster.

Warning: To prevent data loss you must stop the cluster by following the procedure described
in Stopping a Cluster on page 60.

2. On any node in the cluster, install the module or modules you want to add.
3. Open this file in a text editor:

server/app/conf/spectrum-container.properties

4. Inthe spectrum.cluster.seeds property, remove all host names and IP addresses except
for the one for this server. Save the host names and IP addresses so that you can re-add them
later.

5. Save the file.
6. Start the server.

Note: Wait for the server to fully start before proceeding.

7. Inthefile spectrum-container.properties, add the host names and IP addresses that
you had removed.

8. Save the file. You do not need to restart the server.
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Install the modules on each of the other nodes in the cluster. Start each node after installing
the modules on it, and wait for it to fully start before installing the modules on the next node.
You do not need to modify the spectrum.cluster.seeds property when installing modules

on subsequent nodes.
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5 - Spectrum
Databases

After you have installed the server you need to install the databases that
support the modules you have installed. Databases provide the information
that Spectrum™ Technology Platform modules use to process data, such
as postal address data, name data, or geospatial data. For example, if you
have installed the Enterprise Geocoding Module, you will need to install
databases that contain geospatial data; if you have installed the Universal
Addressing Module, you will need to install databases that contain postal

data.

In this section
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Installing Enterprise Routing Module Databases
Installing Enterprise Tax Module Databases
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Installing a Spectrum Database

Spectrum databases contain reference data from trusted data providers that is used to enhance
and validate your data. For example, to perform address validation, Spectrum™ Technology Platform
uses official address data from the postal authority to compare your address to the official address.
Other types of processing that use Spectrum databases include geocoding, location intelligence
functions like point-in-polygon or travel directions, and tax jurisdiction assignment for a given address.

We update Spectrum databases periodically to provide you with the most up-to-date data from
third-party data providers. Database updates occur independently from software updates, in some
cases quarterly or even monthly. When a database update is available you will receive an email
notification that includes a link to download the updated database. You should install it as soon as
possible so that you are using the most accurate data available.

Beginning with Spectrum™ Technology Platform version 12.1, some databases have changed to
support a simpler installation and configuration process. This includes international data that is
consumed by International Geocoding Databases, Installing Global Geocoding Module
Databases, Installing Universal Addressing Module Databases on page 104, and #unique_62.
Refer to those topics for more information.

1. Download your licensed SPD files from the Pitney Bowes eStore using the link provided in the
release announcement or welcome email.

2. Place the . spd files in:

SpectrumLocation/server/app/dataimport

The SPD file is automatically extracted to:
SpectrumLocation/server/app/repository/datastorage

Once the database has been extracted to the datastorage folder, itis installed and you can define
it as a database resource using Management Console. Find more information about Management
Console in the Administration Guide.

You can modify the Spectrum database installation process if needed:

* You can change the location of the data import directory by altering the platform property in the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties file.

* You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.
Consider creating a storage folder outside of Spectrum so it will not be deleted when you uninstall
Spectrum.

* By default, the SPD files are deleted after the files are extracted or when Spectrum is uninstalled.
However, you can archive SPD files by setting the spectrum.data.manager.archive.data property
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to "true" in the Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.
» With any change to the properties files, you must stop and restart the Spectrum server.

Installing the Advanced Matching Module Database

The Advanced Matching Module provides a load utility to install databases. The database files that
you install depend on the databases you have licensed.

Note: To install the Advanced Matching Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.

2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Stop Server.

3. Insert the database DVD or download the database from the Pithey Bowes eStore.

Note: If you download the database from the web site, it will be downloaded as a zip
file. Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. Open the file <SpectrumbDirectory>\server\bin\wrapper\wrapper.conf in a text
editor.

7. Increase the Java settings for initial heap size (wrapper.java.initmemory)and maximum
heap size (wrapper.java.maxmemory) to reflect the total amount of memory required for the
Arabic Plus Pack and Asian Plus Pack.

* Arabic Plus Pack: 5.5 GB

* Asian Plus Pack - Chinese: 32 MB

* Asian Plus Pack - Japanese: 1.6 GB
* Asian Plus Pack - Korean: 8 MB

* Core Names: 1.1 GB

8. Save and close wrapper.conf.

9. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Start Server.
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Installing Data Normalization Module Databases

The Data Normalization Module provides a load utility to install databases for the Advanced
Transformer, Open Parser, and Table Lookup components. The database files that you install
depend on the databases you have licensed. Use this list of database tables to determine which
files you should download and install. For more information about tables contained in each database,
refer to the reference documentation for each component.

Stage Available Databases

Advanced Transformer Data Normalization Module - Base Tables

Open Parser o
» Data Normalization Module - Base Tables

» Core Names Database

» Company Names Database
* Arabic Plus Pack

* Asian Plus Pack

Table Look
able Lookup « Data Normalization Module - Base Tables

» Core Names Database
* Arabic Plus Pack
* Asian Plus Pack

+ ZREPLACE (Used by the SAP Module for French address
validation)

Note: To install the Data Normalization Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.

2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Stop Server.

3. Insert the database DVD or download the database from the the Pitney Bowes eStore. You
received a download link with your product release announcement.

Note: If you download the database from the web site, it will be downloaded as a zip
file. Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Data Normalization Module > Database Load Utility.
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5. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Start Server.

Installing Enterprise Geocoding Module Databases

This module has several databases. You may have one or more of these, depending on the features
you have licensed.

Installing Databases for Enterprise Geocoding and Global Geocoding Modules

International geocoding databases contain the data necessary to perform geocoding and reverse
geocoding for locations outside the U.S. Each country has its own database, and some countries
have optional databases that provide enhanced geocoding.

These databases are for use in the Global Geocoding and Enterprise Geocoding modules.
Note: Do not install geocoding databases on a network drive. Doing so can cause
performance problems.

Note: To install the Enterprise Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1. Download your licensed SPD files from the Pitney Bowes eStore using the link provided in the
release announcement or welcome email.

2. Place the . spd files in:

SpectrumLocation/server/app/dataimport

The SPD file is automatically extracted to:
SpectrumLocation/server/app/repository/datastorage

Once the database has been extracted to the datastorage folder, it is installed and you can define
it as a database resource using Management Console. Find more information about Management
Console in the Administration Guide.

You can modify the Spectrum database installation process if needed:
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* You can change the location of the data import directory by altering the platform property in the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties file.

* You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.
Consider creating a storage folder outside of Spectrum so it will not be deleted when you uninstall
Spectrum.

+ By default, the SPD files are deleted after the files are extracted or when Spectrum is uninstalled.
However, you can archive SPD files by setting the spectrum.data.manager.archive.data property
to "true" in the Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.

» With any change to the properties files, you must stop and restart the Spectrum server.

AUS G-NAF

If you installed the Australia Geocoded National Address File (G-NAF), you must specify the GNAF123
and GNAF456 as separate paths but in the same database resource in Management Console.
GNAF123 contains the point-level dictionary. This has the highest precision of geocoding
(characterized by Reliability Level 1, 2, or 3.) GNAF456 contains the remainder of address information
in G-NAF that does not meet high precision geocoding criteria (characterized by Reliability Level 4,
5, or 6.) We recommend that you use both databases to validate the existence of addresses but
only use GNAF123 for parcel-level geocoding. If you do not require parcel-level geocodes you can
use GNAF45¢6 for geocoding.

U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address standardization
and geocoding. You must install at least one of these databases.

» Centrus Enhanced Geocoding—This database consists of TIGER data provided by the U.S.
Geological Survey and address data provided by the U.S. Postal Service.

» TomTom Geocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. The data is provided by TomTom, a
third-party provider of spatial data, and postal data from the U.S. Postal Service.

+ HERE Geocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. HERE data is provided by HERE, a third-party
provider of spatial data. For more information about these databases, contact your sales
representative.

» ZIP + 4 Centroid—This database provides only address standardization and ZIP + 4 centroid
matching. It does not provide street-level matching.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.
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Each geocoding database has an optional Statewide Intersections Index. The Statewide Intersection
Index is designed to enable fast intersection identification on a statewide basis. For example, the
Statewide Intersection Index will allow the database to search for "1st and Main St, CO" and return
a list of possible matches in Colorado more quickly than searching the entire geocoding database
for each instance of the intersection.

Note: To install the Enterprise Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.

2. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run DataSets.exe. The installation wizard guides you through the rest of the process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. After you install the database files, use the Database Resource tool in the Management Console
to define the database as a resource. For more information, see the Administration Guide.

Points Databases (U.S. Only)

Points databases contain data for locating the center of a parcel. These databases provides enhanced
geocoding accuracy for internet mapping, property and casualty insurance, telecommunications,
utilities, and others.

» Master Location Data —This database provides the best available address point location for
every mailable and deliverable address in the United States.

» Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

» Centrus Elevation—This database contains the same data as Centrus Points, plus elevation
data.

» Centrus Enhanced Points—This database contains the same data as Centrus Points, plus APN
data.

» Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

+ TomTom Points Database—The data in this database is provided by TomTom, a third-party
provider of spatial data.

* HERE Points—This database is provided by HERE, a third-party data provider. It contains data
used to locate addresses at the center of the actual building footprint or parcel.
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Note: To install the Enterprise Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1.  Make sure no applications are running.
2. Insert the database DVD or download the database from the Pitney Bowes eStore. You received
a download link with your product release announcement.

Note: If you download the database from the Pitney Bowes web site, it will be downloaded
as a zip file. Unzip the database before proceeding with the installation.

3. Run setup.exe. The installation wizard guides you through the rest of the process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. After you install the database files, use the Database Resource tool in the Management Console
to define the database as a resource. For more information, see Spectrum™ Technology Platform
Administration Guide.

Early Warning System (U.S. Only)

The USPS provides free Early Warning System (EWS) data to prevent matching errors due to the
age of the address information in the .gsd files. The USPS creates a new EWS data set each week
that you can download from the USPS website (https://postalpro.usps.com/cass/EWS).

To install the Early Warning System (EWS) database rename the database file from OUT to EWS.txt
and place it in the same folder as the primary database.

Installing Enterprise Routing Module Databases

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the the Pitney Bowes eStore. You
received a download link with your product release announcement.

Note: If you download the database from the technical support web site, it will be
downloaded as a zip file. Unzip the database before proceeding with the installation.

3. Routing database is now available in the SPD format. Review the Installation Guide located
inside the zipped file that is shipped with the database.
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Installing SPD-based Routing Data

This section talks about installation process of SPD-based routing data.

Downloading files

You can download the bundled . zip files from the e-store as usual.

Installing SPD-based Routing Data

Steps to deploy data depend on the version of Spectrum™ Technology Platform in use. However,
in all cases, the first step is to extract the . zip file. This is same as was with the older routing data.
For example, America bundle 1 data (A1B), contains following four . spd files:

» CA_Driving.spd

» CA_Pedestrian.spd

» US_Driving.spd (having driving data for all regions in USA)

* US_Pedestrian.spd (having pedestrian data for all regions in USA)

Installing data by manually extracting SPD file
Note:

This method is applicable for Spectrum™ Technology Platform version 11 and older and is
recommended for existing users or those not willing to modify server configurations and
control the runtime location of their data.

» Choose the country specific SPD file of choice, that means driving or pedestrian and extract to the
desired location. You can use any tool to unzip the files. If required by that tool, the sPD file can
be renamed to . zip.

» Ensure that the destination folder is the location where you want to use and manage the data.
This is same as choosing the location from the earlier dbloader tool.

Installing data using data import auto-extract feature

« Installing routing data using data import takes advantage of a Spectrum™ Technology Platform
feature that auto-extracts the data from the sPD file and places it in a standard but configurable
location on your system. Once configured, you just need to copy the SPD file to the “dataimport”
folder.

 There are three locations to be aware of and there are configurations related to them that can be
altered from the default.

» The defaults are all under the installed <SpectrumLocation>. You can choose a different
location to keep your data. If you have to uninstall the software, the data gets removed when using
the defaults.
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* The first location is the “dataimport” folder. If you put an SpD file in that location, Spectrum will
extract the contents of the SPD and store information about it. The folder defaults to
<SpectrumLocation>/server/app/dataimport. Also by default, once Spectrum is finished
extracting, it deletes the sPD file to save space. Ensure to keep a copy of the download file
somewhere else. The dataimport location can be altered by editing the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties file.
Since this is a temporary location used for extracting, the only reason for changing can be a
concern about temporary disk space usage.

* The second location is the permanent home of the data and is called the “data storage” folder.
It defaults to <SpectrumLocation>/server/app/repository/datastorage/. This
location is large enough to hold all the routing, geocoding, or other modules you use. This
contains sPD formatted data which for many countries is quite large. It needs to be on a disk
that is optimal for the purpose. To configure it to a location other than the default, you need to
alter the spectrum.data.manager.storage.directory property in the Data Manager section of
the <SpectrumLocation>/server/app/conf/spectrum-container.properties file.
For Windows users note that the path separator used has to be a “forward” slash. For example,
E:/SpectrumbData/and notE: \SpectrumbData\. Thisis possible that this location is already
modified for geocoding or address data.

* The last location is the archive location. It cannot be changed but by default, archiving is turned
off. When turned on, the sPD file is not deleted after extraction and is moved to
<SpectrumLocation>/server/app/repository/dataimport/archive folder. Turning
on archiving is enabled by changing the property from “false” to “true” in the
spectrum.data.manager.archive.data section of the spectrum-container.properties file right
under the location.

Installing Enterprise Tax Module Databases

Depending on the features you have licensed, you need to install one or more of these databases.
Database Compatibility

The Enterprise Tax Module version 9.0 SP2 and later uses a different data format than previous
releases. You must download and install the GeoTAX/Enterprise Tax Premium database for use
in this version. The GeoTAX/Enterprise Tax Premium database is not compatible with any releases
prior to version 9.0 SP2.
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Downloading Database Files

Note: Prior to downloading the data files: If you have previously installed database files,
you should back up those files and delete any copies of the .gdi, .gsd, gsi, .gsl,
.gsu, .gsz, .gsx, .z9, .dir, .las and .los files inthe datainstall directory.

Downloading from the eStore

Use the link in your welcome email to download the zip file. Extract the files and make note of the
directory where you save the files.

Downloading from the Technical Support Web Site

Download the database from the the Pitney Bowes eStore. You received a download link with your
product release announcement or Welcome letter. The data file will be downloaded as a .zip file.
Extract the files and make note of the directory where you save the files.

Downloading Florida Format Files

You can obtain the Florida format files from the Florida Department of Revenue. The Florida
Department of Revenue compiles the database based on county.

1. Download the files from the Florida website at:
https://pointmatch.state.fl.us/General/AddressFiles.aspx/.
2. Unzip the downloaded files and transfer them to the server.

Note: Be sure to FTP your files in binary format.

3. Combine the county files into a single file if you downloaded more than one county. If you
downloaded the entire state list, you have approximately 67 files. You must combine all the files
into one file.

Your file is ready for loading.

Downloading TS-158 Format Files

The Federation of Tax Administrators (FTA) maintains a website with links to all data sources that
use the TS-158 format.

1. Download the files from the Florida website at:
https://pointmatch.state.fl.us/General/AddressFiles.aspx.
2. Unzip the downloaded files and transfer them to the Spectrum™ Technology Platform server.

3. State files are often broken up into individual county files. Combine all state and/or county files
into a single file.
Your file is ready for loading.
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Database Options

The following describes the database options presented in the Windows Database Load Ulility.

GeoTAX master files

The GeoTAX/Enterprise Tax Premium Database is a required dataset and is the
master file for the Enterprise Tax Module software. The master files identify all
geographic components associated with a street address, such as the
latitude/longitude, census tract, and block group.

Point Data files

Point Data products include Master Location Data (MLD), Centrus Points, HERE
Points, and TomTom Points. The point data provides point-level geocoding for the
most accurate placement of addresses throughout the U.S. The Master Location
Data database provides the best available address point location for every mailable
and deliverable address in the United States.

User auxiliary file

This is a user-defined file that the Enterprise Tax Module uses to override results
from the master files in street-level matching. If you have data that is more current
than that in the master files, you can enter the new data into the auxiliary file and use
it for your address matching. The Enterprise Tax Module returns matches made with
a code that signifies the answer came from the auxiliary file. You can also return
user-defined data from the auxiliary file with the match. The install program creates
the file G1GTAUX in the specified destination.

GeoTAX auxiliary file

This file contains new addresses that have not yet been added to the master files. It
provides the most up-to-date address data possible. The install program creates the
indexed sequential file GIGTAX2 in the specified destination.

Landmark auxiliary file

This is a user-defined file that allows you to specify customized address information
in your input records. The recommended primary use of this file to match to your
company’s non-address locations such as well heads, transmission towers or any
other descriptive location. The latitude/longitude that is part of the input needed to
build this file allows companies to automatically keep track of any jurisdictional
changes that affect these unique locations. Matching to this file requires that the input
record information match exactly to the Landmark file contents. This also applies to
street records if you choose to enter them in the Landmark file. For more information,
refer to the Enterprise Tax Module Guide.

State-supplied Florida format file

This is a state-supplied file in Florida-native format which is provided by individual
state governments. The Enterprise Tax Module first attempts to match to the state
database. If the Enterprise Tax Module cannot find a state match, it attempts a match
to the GeoTAX Auxiliary file, if loaded, then to the master files.
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State-supplied TS-158 format file

This is a state-supplied file in TS-158 (ANSI Transaction Set No. 158) format which
is provided by individual state governments. The Enterprise Tax Module first attempts
to match to the state database. If the Enterprise Tax Module cannot find a state
match, it attempts a match to the GeoTAX Auxiliary file, if loaded, then to the master
files.

Boundary file
Boundary files provide additional data about locations of special tax districts:

» Special Purpose Tax Districts (spd.txb)

* Insurance Premium Tax Districts (ipd.txb)
 Payroll Tax Districts (pay.txb)

» User-defined Boundary file (usr.txb)

PB Software tax rate file

The Pitney Bowes Sales and Use Tax Rate file allows you to use the Enterprise Tax
Module to provide sales and use tax rates for each of the assigned tax jurisdictions
as well as the total rate for the assigned locations. The install program creates the
indexed sequential file GTTAXRT.

Payroll tax correspondence file

Payroll tax cross-reference file allow you to use third-party software to determine the
payroll tax rates. The cross-reference files combine the U.S. Government Federal
Information Processing Standards (FIPS) codes with the proprietary geocodes used
by tax software from third parties. The Payroll System Tax Code file is a customized
file that you build to return the payroll tax codes used by your payroll system. The
install program produces database files called G1GTPTC and G1GTPTC.vix.

Sovos cross reference file

This sales tax cross-reference file enables you to use the Enterprise Tax Module to
determine tax jurisdictions for a given address, then use Sovos software to determine
the sales tax rates for those jurisdictions.

PB Software Vertex® cross reference file

This is a Vertex® cross-reference file supplied by Pitney Bowes. The install program
produces a database file GTMSTR?2 in the specified destination.

Installing the Database Files

1. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Enterprise Tax Module > Database Load Utility.
The Database Load Utility window launches.

2. Select the database you want to install.

Note: For Point Data, select the GeoTAX master files option.
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3. Follow the instructions provided by the wizard.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. In Management Console, open the Enterprise Tax Module database resource tool and define
a database resource that includes the database you just installed. Be sure to update Assign
GeoTAX Info and Reverse GeoTAX Info Lookup to use the new database resource.

Installing GeoEnrichment Module Databases

. Download your database(s). The database is downloaded as a .tar.bz2 file.
2. Extract the .tar.bz2 file.

Tip: A tool that supports extracting the .tar.bz2 and .tar formats is "7-Zip". This open-source
tool can be downloaded from: http://www.7-zip.org/download.html

3. Extract the .tar file.
4. Copy the data to any directory. Note the file name and path.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. After you install the database files, you will need to define the database as a resource. For more
information, see "Adding a GeoEnrichment Module Database Resource" in the GeoEnrichment
Guide on support.pb.com.

Installing Global Addressing Module Databases

This procedure describes how to download and install Global Addressing Module databases in the
Spectrum™ Product Database (SPD) format from the Pitney Bowes eStore.

Disk Space
The disk space requirements for extracted and non-extracted SPD bundles are:

+ Extracted bundles (all SPD) - 50 GB
* Non-extracted bundles (all SPD) - 20 GB

Memory
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The following table provides information on the Global Address Module memory requirements for
each country database.

Table 1: Global Address Validation Memory Requirements (in Megabytes)

Country Database Name  Global Address Validation  Global Type Ahead Both
Argentina (ARG) 700 n/a n/a
Australia (AUS) 700 n/a n/a
Austria (AUT) 900 700 1900
Belgium (BEL) 900 700 1900
Brazil (BRA) 700 700 700
Canada (CAN) n/a n/a n/a
China (CHN) 700 n/a n/a
Czech Republic (CHZ) 700 n/a n/a
Denmark (DNK) 2100 700 3400
Finland (FIN) 900 700 1900
France (FRA) 2800 700 4100
Germany (DEU) 700 700 1900
Greece (GRC) 700 n/a n/a
India (IND) 700 n/a n/a
Ireland (IRL) 900 700 1900
Italy (ITA) 700 700 1900
Japan (JPN) 700 n/a n/a
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Country Database Name  Global Address Validation  Global Type Ahead Both
Malaysia (MYS) 700 n/a n/a
Mexico (MEX) 700 n/a n/a
Netherlands (NLD) 700 n/a n/a
New Zealand (NZL) 700 n/a n/a
Norway (NOR) 700 700 1900
Poland (POL) 700 n/a n/a
Russia (RUS) 700 n/a n/a
Spain (ESP) 1300 700 1900
Sweden (SWE) 900 n/a n/a
Switzerland (CHE) 700 700 1900
United Kingdom (GBR) 980 700 1900
United States (USA) n/a 800 n/a
United States (USA) Domestic 50 n/a n/a
(GAV_US_DOM)

United States (USA) 50 n/a n/a

Non-Domestic
(GAV_US_NON-DOM)

To download and install a Global Addressing Module database resource in the Spectrum”™ Product

Database (SPD) format:

1. Make sure no applications are running.

2. Select and download your licensed SPD files (xxx.spd) from the Pitney Bowes eStore using the

link provided in the release announcement or welcome email.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the

installation.
4. Install the SPD files:
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a) Place the SPD files in <SpectrumLocation>/server/app/dataimport. This is the
default location for SPD files. The Spectrum™ Technology Platform server monitors this
folder and looks for new files in two-second intervals.

You can change the location of the data import directory by altering the platform property
in the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties
file.

b) When the server detects new SPD files, the server automatically extracts the SPD files to
<SpectrumLocation>/server/app/repository/datastorage

You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager settings section
ofthe <SpectrumLocation>/server/app/conf/spectrum-container.properties
file.

c) By default, the SPD files are deleted after the files are extracted. However, you can archive
SPD files by setting the spectrum.data.manager.archive.data property to "true" in the
Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.

d) At this point the data will become available and you can add it as a Spectrum™ database
resource in the Spectrum™ Databases section of Management Console.

e) Afteryou install the database files, use either the Database Resource tool in the Management
Console or the Global Addressing Administration Utility database commands to define the
database as a resource. For more information on the Administration Utility database
commands, see the section "Global Addressing Module Databases" in the Spectrum™
Technology Administration Guide.

Installing Global Geocoding Module Databases

This module supports databases for both US and non-US countries.
Installing Databases for Enterprise Geocoding and Global Geocoding Modules

International geocoding databases contain the data necessary to perform geocoding and reverse
geocoding for locations outside the U.S. Each country has its own database, and some countries
have optional databases that provide enhanced geocoding.

These databases are for use in the Global Geocoding and Enterprise Geocoding modules.

Note: Do not install geocoding databases on a network drive. Doing so can cause
performance problems.
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Note: To install the Enterprise Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1. Download your licensed SPD files from the Pitney Bowes eStore using the link provided in the
release announcement or welcome email.

2. Place the . spdfiles in:

SpectrumLocation/server/app/dataimport

The SPD file is automatically extracted to:
SpectrumLocation/server/app/repository/datastorage

Once the database has been extracted to the datastorage folder, itis installed and you can define
it as a database resource using Management Console. Find more information about Management
Console in the Administration Guide.

You can modify the Spectrum database installation process if needed:

* You can change the location of the data import directory by altering the platform property in the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties file.

* You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.
Consider creating a storage folder outside of Spectrum so it will not be deleted when you uninstall
Spectrum.

» By default, the SPD files are deleted after the files are extracted or when Spectrum is uninstalled.
However, you can archive SPD files by setting the spectrum.data.manager.archive.data property
to "true" in the Data Manager settings section of the
<SpectrumLocation>/server/app/conf/spectrum-container.properties file.

» With any change to the properties files, you must stop and restart the Spectrum server.

AUS G-NAF

If you installed the Australia Geocoded National Address File (G-NAF), you must specify the GNAF123
and GNAF456 as separate paths but in the same database resource in Management Console.
GNAF123 contains the point-level dictionary. This has the highest precision of geocoding
(characterized by Reliability Level 1, 2, or 3.) GNAF4 56 contains the remainder of address information
in G-NAF that does not meet high precision geocoding criteria (characterized by Reliability Level 4,
5, or 6.) We recommend that you use both databases to validate the existence of addresses but
only use GNAF123 for parcel-level geocoding. If you do not require parcel-level geocodes you can
use GNAF456 for geocoding.
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U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address standardization
and geocoding. You must install at least one of these databases.

» TomTom Geocoding—This database provides street segment data by TomTom, a third-party
provider of spatial data, and postal data from the U.S. Postal Service.

+ HERE Geocoding—This database provides street segment data by HERE, a third-party provider
of spatial data.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide Intersection
Index is designed to enable fast intersection identification on a statewide basis. For example, the
Statewide Intersection Index will allow the database to search for "1st and Main St, CO" and return
a list of possible matches in Colorado more quickly than searching the entire geocoding database
for each instance of the intersection.

Note: To install the Global Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

1. Make sure no applications are running.

2. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run DataSets.exe. The installation wizard guides you through the rest of the process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. After you install the database files, use either the Global Geocoding Database Resource tool
in the Management Console or the Global Geocoding CLI database commands to define the
database as a resource. For more information, see the Administration Guide.

Points Databases (U.S. Only)

Points databases contain data for locating the center of a parcel. These databases provides enhanced
geocoding accuracy for internet mapping, property and casualty insurance, telecommunications,
utilities, and others.

Spectrum™ Technology Platform 2018.2.0 Installation Guide 100



Spectrum Databases

Note: To use a points database, you must also install a streets database. See U.S.
Geocoding Databases on page 100 for the list of available US streets databases.

» Master Location Data —This database provides the best available address point location for
every mailable and deliverable address in the United States.

» Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

» Centrus Elevation—This database contains the same data as Centrus Points, plus elevation
data.

» Centrus Enhanced Points—This database contains the same data as Centrus Points, plus APN
data.

» Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

» TomTom Points—The data in this database is provided by TomTom, a third-party provider of
spatial data.

+ HERE Points—This database is provided by HERE, a third-party data provider. It contains data
used to locate addresses at the center of the actual building footprint or parcel.

Note: To install the Global Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

1. Make sure no applications are running.

2. Insert the database DVD or download the database from the Pitney Bowes eStore. You received
a download link with your product release announcement.

Note: If you download the database from the Pitney Bowes web site, it will be downloaded
as a zip file. Unzip the database before proceeding with the installation.

3. Run setup.exe. The installation wizard guides you through the rest of the process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. After you install the database files, use either the Global Geocoding Database Resource tool
in the Management Console or the Global Geocoding CLI database commands to define the
database as a resource. For more information, see the Administration Guide.

Installing the Global Sentry Module Database

These databases are required to run Global Sentry in real-time mode:

» ofac.db
* pep.db
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* sanctions.db
These files are required to run Global Sentry in batch mode:

+ globalsentrydb.addresses-ofac.csv

+ globalsentrydb.fullNames-ofac.csv

* globalsentrydb.ids-ofac.csv

* globalsentrydb.names-ofac.csv

* globalsentrydb.addresses-pep.csv

+ globalsentrydb.fullNames-pep.csv

* globalsentrydb.ids-pep.csv

* globalsentrydb.names-pep.csv

+ globalsentrydb.addresses-sanctions.csv
* globalsentrydb.fullNames-sanctions.csv
* globalsentrydb.ids-sanctions.csv

* globalsentrydb.names-sanctions.csv

In addition, you must install the Data Normalization Module and Advanced Matching Module
databases to use Global Sentry. For instructions, see Installing Data Normalization Module
Databases on page 85 and Installing the Advanced Matching Module Database on page 84.

Ensure the Global Sentry Database Server is in up and running. In case it is not, use the option in
the utility to start it before you begin data loading.

Note: You need to perform data loading after every upgrade of Spectrum™ Technology
Platform.

—_—

Stop the Spectrum™ Technology Platform server.
2. Insert the database DVD or download the database from the technical support web site.

Note: If you download the database from the Pitney Bowes web site, it will be downloaded
as a zip file. Unzip the database before proceeding with the installation.

3. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Global Sentry Module > Global Sentry Module Database Load Utility.

4. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Start Server.

6. After installing the Global Sentry Module database, you must configure a JDBC connection in
the Spectrum™ Technology Platform Management Console. Go to Start > Settings > Control
Panel > Administrative Tools > Services to verify that the Global Sentry Database is running.

7. Login to the Management Console and configure the driver and connection properties using
these steps:
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a) Inaweb browser go to this URL:
http://server.port/managementconsole

Where server is the server name or IP address of your Spectrum™ Technology Platform
server and port is the HTTP port used bySpectrum™ Technology Platform. By default, the
HTTP port is 8080.

b) Enter your user name and password to access the Home page of the Management Console.
c) On the Main Menu, click Systems > Drivers to open the Drivers page

d) Click Add

e) Type these JDBC properties in the applicable text boxes:

+ JDBC driver configuration name: HSQLDB
+ JDBC driver class name: org.hsqldb.jdbcDriver
« Connection string template: jdbc:hsqldb:hsql://${host}:${port}/${instance}

f)  Add this driver file:
<SpectrumPlatformLocation>/GlobalSentryDatabase/lib/hsgldb.jar

g) To define connection properties, go to Resources > Data Sources.
h) Click Add, and define these connection properties:

» Connection name: Global Sentry
» Database driver: select the HSQLDB JDBC driver that you created in the previous steps.

i) Enter these values in the Connection Properties dialog box:

* user: sa
» password: <there is no password>

* host: localhost or <your server name>
* port: 9001

* instance: globalsentrydb

j) Click Test to verify the connection works.
k) Click OK, then click Save

Installing Location Intelligence Module Databases

1. Place the data on the file system, or install the data into a database.

2. Use Spatial Manager to define Location Intelligence Module database resources (named
connections and tables). For more information, see the "Configuring Database Resources"
chapter of the Spectrum™ Technology Platform Administration Guide on support.pb.com.
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Installing Universal Addressing Module Databases

Note: This section is valid only for users of UAM- US , UAM- Canada, and UAM- International.

You can download and install Universal Addressing Module databases in the Spectrum™ Product
Database (SPD) format. You can't install older databases or vintages. After upgrading to Spectrum™
Technology Platform version 2018 H2 from any previous version, you must delete and reconfigure
all the previously configured databases using SPDs.

This procedure describes how to download and install Universal Addressing Module databases in
the Spectrum™ Product Database (SPD) format from the Pitney Bowes eStore.

Disk Space
The disk space requirements for extracted and non-extracted SPD bundles are:

» Extracted bundles (all SPD) - 50 GB
» Non-extracted bundles (all SPD) - 20 GB

To download and install a Universal Addressing Module database resource in the Spectrum™ Product
Database (SPD) format:

1. Make sure no applications are running.

2. Select and download your licensed SPD files (xxx.spd) from the Pithey Bowes eStore using the
link provided in the release announcement or welcome email.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. |Install the SPD files:

a) Place the SPD files in <SpectrumLocation>/server/app/dataimport. This is the
default location for SPD files. The Spectrum™ Technology Platform server monitors this
folder and looks for new files in two-second intervals.

You can change the location of the data import directory by altering the platform property
in the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties
file.

b) When the server detects new SPD files, the server automatically extracts the SPD files to
<SpectrumLocation>/server/app/repository/datastorage.

You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager settings section
ofthe <SpectrumLocation>/server/app/conf/spectrum-container.properties
file.

c) By default, the SPD files are deleted after the files are extracted. However, you can archive
SPD files by setting the spectrum.data.manager.archive.data property to "true" in the
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Data Manager settings section of the
<SpectrumlLocation>/server/app/conf/spectrum-container.properties file.

d) At this point the data will become available and you can add it as a Spectrum™ database
resource in the Spectrum™ Databases section of Management Console.

e) After you install the database files, use either the Database Resource tool in Management
Console or the Universal Addressing Administration Utility database commands to define
the database as a resource. For more information about the Administration Utility database
commands, see the section "Universal Addressing Module Databases" in the Administration
Guide.

Installing Validate Address AUS Databases

This procedure describes how to install databases used by the Validate Address AUS stage.

Note: To install the Universal Addressing Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.

2. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Addressing Module > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

Installing Validate Address Global Databases

This procedure describes how to install the databases used by the Validate Address Global stage.
For instructions on installing databases used by other Universal Addressing Module stages, see
the Spectrum™ Technology Platform Administration Guide.

1. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Unzip the database file to the location you want. The database zip files are:
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* VAGlobal-EMEA .zip—Contains the data for Europe, Middle East, and Africa.
* VAGIobal-APAC.zip—Contains the data for Asia-Pacific.
* VAGlobal-Americas.zip—Contains the data for the Americas.

Note: You may install databases on a network share, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. Stop the Spectrum™ Technology Platform. To do this, open the Windows system tray and select
Stop Spectrum™.

5. Install the unlock code:
a) Open the following file in a text editor:
<SpectrumLocation>\server\modules\addressglobal\conf\unlockcodes.txt

b) Enter your unlock codes, one per line.
c) Save and close the file.

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the system tray and select Start Spectrum™.

Installing Validate Address Logate Databases

This procedure describes how to install the databases used by the Validate Address Logate stage.
For instructions on installing databases used by other Universal Addressing Module stages, see
the Spectrum™ Technology Platform Administration Guide.

1. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Unzip the database file(s) to the location you want. If you are installing data from multiple zip
files or discs, be sure to unzip them all to the same location. The database zip files are:

* LQO/DB_Setup—Contains general database setup files.

Note: Regardless of which set of data you use, the files in LQO must be installed.

* LQ1/APAC_AFR_ME-I—Contains the data for Asia-Pacific, Africa, and Middle East.

* LQ2/Americas-l—Contains the data for the Carribbean, Central America, and South America.
* LQ3/Europe-l—Contains the data for Eastern and parts of Western Europe.

* LQ4/Americas-lIl—Contains the data for parts of North America.

* LQ5/Europe-ll—Contains the data for parts of Western Europe.

» LQ6/Americas-lll—Contains the data for parts of North America.

* LQ7/APAC_AFR_ME-Il—Contains the data for parts of Asia-Pacific, Africa, and Middle East.
» LQ8/Europe-lll—Contains the data for parts of Western Europe.
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Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. From the location where you extracted the database files, right-click install.bat and select Run
as administrator. This will launch the Logate Installer.

5. Follow the prompts during the rest of the installation process.

Installing Universal Name Module Databases

The Universal Name Module provides a load utility to install databases. The database files that you
load depend on the databases you have licensed.

Note: To install the Universal Name Module databases on Windows Server 2008 you need
administrator privileges.

1. Make sure no applications are running.
2. Stop the Spectrum™ Technology Platform server.

3. Insert the database DVD or download the database from the the Pitney Bowes eStore. You
received a download link with your product release announcement.

Note: If you download the database from the web site, it will be downloaded as a zip
file. Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Database Load Utility.

5. Follow the prompts to complete the installation process. The database files are you can install
are:

» Arabic Plus Pack: gl1-cdg-cjki-arabic-<date>.jar

» Asian Plus Pack - Chinese: gl-cdg-cjki-chinese-<date>.jar

» Asian Plus Pack - Japanese: gl-cdg-cjki-japanese-<date>.jar
 Asian Plus Pack - Korean: g1-cdg-cjki-korean-<date>.jar

» Core Names Database: gl-cdg-nomino-base—-<date>.jar

Note: You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. To load the complete Core Names Database, you must also install Open Parser and Table
Lookup data from the Data Normalization Module Database Load Utility.
a) Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform >
Modules > Data Normalization Module > Database Load Utility > Open Parser.

Spectrum™ Technology Platform 2018.2.0 Installation Guide 107



Spectrum Databases

b) Follow the prompts to complete the installation process. The database file you need to install
is:

» cdg-OpenParser-EnhancedNames.tba

c) Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform >
Modules > Data Normalization Module > Database Load Utility > Table Lookup.

d) Follow the prompts to complete the installation process. The database file you need to install
is:

» cdg-TableLookup-EnhancedGenderCodes.tha

7. Open the file <SpectrumbDirectory>\server\bin\wrapper\wrapper.conf in a text
editor.

8. Increase the Java settings for initial heap size (wrapper.java.initmemory)and maximum
heap size (wrapper.java.maxmemory) to reflect the total amount of memory required for the
Arabic Plus Pack and Asian Plus Pack.

* Arabic Plus Pack: 5.5 GB

* Asian Plus Pack - Chinese: 32 MB

* Asian Plus Pack - Japanese: 1.6 GB
* Asian Plus Pack - Korean: 8 MB

* Core Names: 1.1 GB

9. Save and close wrapper.conf.

10. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Start Server.

Using the Database Silent Installer

The silent install process allows you to pre-configure the database installation process so that it
runs without user intervention. Instead of responding to prompts from the installation process for
information such as the installation location, you specify these responses in a properties file that
the installer uses instead of user prompts.

Using the Logate Database Silent Installer

1. In the Spectrum™ Technology Platform server installer (not the database installer), browse to
the SilentInstaller folder.

2. Using a text editor, open the uam logate.installer.properties file.
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3. Edit the properties file as necessary to specify the installation settings you want to use. See the
comments in the properties file for additional information.

4. To run the installer in silent mode, place the properties file in any directory except the location

where you are going to install the Logate data and give the absolute path to the property in the
command prompt, as follows:

install.bat %$PathOfPropertyFile%\uam logate.installer.properties
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Installing the Client Tools

The Spectrum™ Technology Platform client tools are applications that you use to administer your
server and design and run dataflows and process flows. You must install your Spectrum™ Technology
Platform server before installing the client tools.

Before installing, be sure to read the release notes. The release notes contains a list of known
issues, important compatibility information, and release-specific installation notes.

This procedure describes how to install the following client tools:

» Enterprise Designer— Use Enterprise Designer to create, modify, and run dataflows.

» Job Executor—Job Executor is a command line tool that allows you to run a job from a command
line or script. The job must have been previously created and saved on Spectrum™ Technology
Platform using Enterprise Designer.

* Process Flow Executor—Process Flow Executor is a command line tool that allows the execution
of a process flow from a command line or script. The process flow must have been previously
created and saved on Spectrum™ Technology Platform using Enterprise Designer.

* Administration Utility—The Administration Utility provides command line access to several
administrative functions. You can use it in a script, allowing you to automate certain administrative
tasks. You can also use it interactively.

Note: As of Spectrum version 11.0, Management Console is a web-based tool rather than
installable client as it was in previous releases.
To install the client tools:
1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:
http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform” and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. Click Platform Client Tools.
3. Download the client tool you want to install.
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Installing Enterprise Designer with a Silent Installer

The silent install process installs Enterprise Designer without user intervention. Instead of prompting
the user for information such as the installation location, the installer uses pre-configured selections
that you specify.

To use the silent installer you must first create an installer properties file by running the client installer
and responding to the prompts. The resulting properties file can then be used to silently install
Enterprise Designer on other computers.

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:
http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform” and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. Click Platform Client Tools.
3. Click Download Installer.
4. Choose to save the file to a location on your computer.
Note: Save the installer on a Windows computer that does not already have Enterprise

Designer installed. You will need to run the installer in order to specify the options you
want to use in the silent install process.

5. Open a Windows command prompt.
6. Inthe command prompt, change directories to the directory where you saved the installer.
7. Execute the following command:

Setup.exe -r installer.properties

8. Respond to the installer prompts by selecting the options that you want to use when the installer
runs silently.

For example, if you want the silent installer to install Enterprise Designer to
C:\Spectrum\EnterpriseDesigner, specify C:\Spectrum\EnterpriseDesigner when
prompted for an installation folder.

When the installer finishes running, a properties file named installer.properties is created
in the same folder as the Setup.exe file.

9. Openthefile installer.properties in a text editor.
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10. Add the following on line 8 of the file:
INSTALLER UI=silent

Note: This is case sensitive to be sure to enter it exactly as shown above.

11. Save and close the properties file.

You have now configured a properties file that will enable you to install Enterprise Designer
silently.

12. To install Enterprise Designer silently, place installer.properties and Setup.exe inthe
same folder on the computer where you want to install Enterprise Designer and run Setup . exe.
When the installer executes it will detect installer.properties and automatically run in
silent mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the -f argument, as follows:

Setup.exe -f PathOfPropertyFile\installer.properties

Upgrading Enterprise Designer

Upgrading from 12.0 or 11.0 SP1

If you are upgrading to Spectrum™ Technology Platform 12.0 SP1 from 12.0 or 11.0 SP1, you do
not need to upgrade Enterprise Designer. However, you should delete this file before logging into
12.0 SP1:

C:\Users\UserName\AppData\Roaming\Pitney Bowes\Enterprise
Designer\Settings.xml

Upgrading from a version prior to 11.0

If you are upgrading to Spectrum™ Technology Platform 12.0 SP1 from a version prior to 11.0 SP1,
you must upgrade Enterprise Designer due to security changes.

Important: Once you upgrade your server to 12.0 SP1, you will not be able to log in to Enterprise
Designer until you upgrade it.

To upgrade Enterprise Designer:

1. Uninstall the existing client tools by going to Start > All Programs > Pitney Bowes > Client
Tools > Setup.
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2. Make sure that you have .NET 4.6 installed on the client machine. This is a newer version of
.NET than was required in previous releases. Note that Windows 10 comes with this version of
.NET installed by default.

3. Download the client tools installer from the Spectrum™ Technology Platform welcome page,
http://SpectrumServer.Port. The default port is 8080.

4. Run the installer.

Removing Enterprise Designer

1. Back up any files you may need in the future.
2. Use the Windows Add/Remove Programs control panel to uninstall Enterprise Designer.
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Installing the Client API

The Client APl is used to integrate Spectrum™ Technology Platform functionality into your
applications. If you will be creating your own program to call Spectrum™ Technology Platform, you
need to install the Spectrum™ Technology Platform Client APl on the system where you will be
developing your application. The Client API allows access to Spectrum™ Technology Platform
through several programming languages, including Java, C++, and web services.

1. Open the folder where you have downloaded the Spectrum™ Technology Platform Client API
installer.

2. Double-click the file sdkinst.exe.
3. The installer guides you through the installation process.

Removing the Client AP

Use the Windows Add/Remove Programs control panel to uninstall the Spectrum™ Technology
Platform Client API.
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Configuring SAP

Integrating with SAP

To integrate Spectrum™ Technology Platform with SAP, you need to install supporting databases
and dataflows on the Spectrum™ Technology Platform server, and then configure your SAP system
to communicate with Spectrum™ Technology Platform. Once you do this, users of SAP will have
access to address validation and geocoding functionality from within SAP.

1. Onthe Spectrum™ Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Logate

Universal Addressing Module - U.S. Database UAM_US

2. When you install the SAP Module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into Spectrum™ Technology Platform.

a) Ifyou are adding the Address Now Module, Enterprise Tax Module, or Universal Addressing
Module to an existing installation, open Spectrum™ Technology Platform Enterprise Designer,
select View > Server Explorer, and delete this dataflow:
SAPValidateAddressWithCandidates.

b) Goto: SpectrumFolder\server\modules\dataflows\sap.
c) Review the following table then copy the applicable dataflow files to:
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SpectrumFolder\server\app\import

If you are installing this set of
modules

Copy these dataflow files to the import folder

Universal Addressing Module

SAPValidateAddressWithCandidates.df
SAPValidateAddressWithCandidates.UAM.df

Enterprise Geocoding Module

SAPValidateAddressWithCandidates.EGM.df

Enterprise Geocoding Module
Universal Addressing Module

SAPValidateAddressWithCandidates.UAM_EGM.df

Enterprise Tax Module
Universal Addressing Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df

Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module

SAPValidateAddressWithCandidates.UAM_ETM_EGM.df

Universal Addressing Module without
Loqate

SAPValidateAddressWithCandidate_ UAM.df

Universal Addressing Module without
Loqate
Enterprise Tax Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df

Universal Addressing Module with
Logate

ValidateAddressWithCandidates_ UAM_Loqate.df

Universal Addressing Module with
Logate
Enterprise Geocoding Module

ValidateAddressWithCandidates_ UAM_Loqate_ EGM.df
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If you are installing this set of Copy these dataflow files to the import folder
modules

Universal Addressing Module with ValidateAddressWithCandidates_ UAM_Loqate_ETM.df
Logate
Enterprise Tax Module

Universal Addressing Module with ValidateAddressWithCandidates_ UAM_Loqate_ EGM_ETM.df
Logate

Enterprise Geocoding Module

Enterprise Tax Module

Universal Addressing Module, Logate ValidateAddressWithCandidates_Loqate.df
only

Universal Addressing Module, Logate ValidateAddressWithCandidates_Logate  EGM.df
only
Enterprise Geocoding Module

Enterprise Geocoding Module GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_ EGM.df

Enterprise Tax Module ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ ETM.df
SAPBatchAssignGeoTAXInfo.df

Note: If errors occur in Management Console or Enterprise Designer, delete the
contents of <WindowsTemporaryDirectory>\glAssemblies, where
<WindowsTemporaryDirectory> is one of these: % TMP%, % TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C: \Documents and
Settings\<USERNAME>\Local Settings\Temp\glAssemblies. After deleting
the contents of this folder, log in again.

3. Import .SAR files.

A .SARfile is a file that contains a third-party add-on package for SAP, such as the Spectrum™
Technology Platform SAP Module. The .SAR file is located on the Spectrum™ Technology
Platform installer in the SAP Objects folder. For information about importing .SAR files into
SAP applications, see your SAP Basis administrator.
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4. Activate the business configuration (BC) sets. The activation options and sequence differs for
ECC and CRM installations.

a) Activate BC sets for ECC and S/4 HANA installations

1. Log-on to the client where the settings for the Spectrum™ Technology Platform SAP
Module is to be configured.

2. Enter the transaction code SCPR20. This activates BC sets and places the default
entries on the Spectrum™ Technology Platform customizing tables.

3. Inthe BC Setfield, enter keyword *hsgrp1* and find all the BC Sets in this namespace.

4. Activate it with the options Overwrite All Data and Default Mode.

I@Actwatiun Options

iz =

Caution You have started the BC Set activation If you continue, new data ‘fﬁ
-
=

records will be created and/or existing ones ovenaritten.

Activation Information Activation Options
ctivated By:! FSALVADOR Overwite Data
Date/Time: 15082008 / 160605 ® Ovenwrite All Data
SystemiClient: DCE {100 O Default Yalues not Overwtitten
Waorkbench Regst: Mot Reguired
Customizing Regst DCERA001 05 Select Activation Mode
Activation Links: Create Locally @ Default Mode (Reccomend)
() Expert Made
Activation Languages: German
English H
[4]
[
T

5. Select and activate the BC sets with the activation options set to Overwrite All Data
and Expert Mode

Note: Activate these BC sets in the order listed.

/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/BCSET_BC_BAS_PV
/HSGRP1/BCSET_BUPA_CUSTOM
/HSGRP1/BCSET_DQC_CUSTOM
/HSGRP1/BCSET_VENDOR
/HSGRP1/DD_TCODE
/HSGRP1/FUZZY_SEARCH_INPUT_PARAM
/HSGRP1/MERGE_SETTINGS
/HSGRP1/ONP_PO
/HSGRP1/SPOD_CON_TABLE
/HSGRP1/SPOD_IN_TABLE
/HSGRP1/SPOD_OPT_TABLE
/HSGRP1/SPOD_OUT_TABLE
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/HSGRP1/SPOD_PO

b) Activate BC sets for CRM installations where ICWC isn’t required (IC Web Client)

1.

5.

Log-on to the client where the settings for the Spectrum™ Technology Platform SAP
Module is to be configured.

Enter the transaction code sSCPR20. This activates BC sets and places the default
entries on the Spectrum™ Technology Platform customizing tables.

In the BC Set field, enter keyword *hsgrp1 * and find all the BC Sets in this namespace.
Activate it with the options Overwrite All Data and Default Mode.

| = Astivation Options

E<!':, [

Caution You have started the BC Set activation If you continue, new data ‘”ﬁ
L[
=

records will be created andfor existing ones ovenaritten.

Activation Information Activation Options
Activated By FSALVADOR Overwrite Data
DatefTime: 15.09.2008 / 16:06:05 (@ (warwrite Al Data
SystemiClient: DCE {100 (O Default Yalues not Overwritten
Warkbench Regst: Mot Reguired
Customizing Reqgst: DCEKI00105 Select Activation Mode
Activation Links: Create Locally @ Default Mode (Reccomend)
O Expert Mode
Activation Languages: German
English H
[«]
-]
| I—(K1D

Select and activate the BC sets with the activation options set to Overwrite All Data
and Expert Mode

Note: Activate these BC sets in the order listed.

/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/BCSET_BC_BAS_PV
/HSGRP1/FUZZY_SEARCH_INPUT_PARAM
/HSGRP1/MERGE_SETTINGS
/HSGRP1/ONP_PO_CRM
/HSGRP1/SPOD_CONFIG
/HSGRP1/SPOD_IN_TABLE
/HSGRP1/SPOD_OPT_TABLE
/HSGRP1/SPOD_OUT_TABLE
/HSGRP1/SPOD_PO_CRM

5. Set up the RFC destination for Spectrum OnPremise.

a) Enter transaction code sM59.
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b) Click Create.

c) Inthe RFC Destination field, enter a name of your choice.

d) Inthe Connection Type field, enter G (HTTP connection to external server).
e) Inthe Description 1 field, enter a meaningful description.

f) Press the Enter key.

g) Click the Technical Settings tab.

h) Inthe Target Host field, enter the computer name or IP Address of the Spectrum™
Technology Platform server.

i) Inthe Service No field enter 8080.

j) Click the Special Options tab.

k) Select No Timeout.

) Select HTTP 1.1.

m) After you save, click Connection Test.

Note: If there is a pop-up window, check the Accept All Further Cookies box and
select YES.

n) When the test is successful, go to the Response Body tab to view the Spectrum™
Technology Platform page.

Note: To setup RFC Destination for Spectrum OnDemand, seelntegration of SAP
with Spectrum on Demand.

6. Set up the Spectrum™ Technology Platform Logging Object
a) Enter transaction code SL.GO.
b) Click New Entries.
c) Inthe Object column, enter /HSGRP1/DQC.
d) Inthe Object text column, enter DQC Logging.
e) Save the change.

7. Configure the BuildGlobalAddress web service in the SAP Visual Admin:
a) Goto<drive>:/usr./sap/<system id>/DVEBMGS01/ j2ee/admin and click go.bat
and enter J2EE_ADMIN as password.
b) Go to Cluster > Server > Services > JCo RFC Provider and select the Bundles tab.
c) Enter all the information needed by the application and click Set to save the changes.
d) Go to Cluster > Server > Services > Web Services Security.

e) Create a proxy in Web Services Client > sap.com > Dynamic WSProxies with the name
PBBIWebServiceConnectorBGA.

f) For the URL, enter:
http://<spectrumservername>:<port>/soap/BuildGlobalAddress?wsdl
For example,

http://MySpectrumServer:8080/soap/BuildGlobalAddress?wsdl
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g) Restart the application server.

8. If you will be using French address validation, you must install the Data Normalization Module
table cdg-TableLookup-SAP. tba on the Spectrum™ Technology Platform server. For more
information, see the Spectrum™ Technology Platform Installation Guide.

9. To configure DPV and RDI options, open T-code/hsgrpl/options, and specify Y (to enable)
or N (to disable), as needed.

* PVPO: For PO Box address validation
* PVST: For street address validation

* PVQU: For batch address validation

Installing Support Files for Read from SAP

The Read from SAP stage reads data from an SAP database as input to a Spectrum™ Technology
Platform dataflow. In order for the Read from SAP stage to access data in your SAP system you
must make the following changes on your SAP system:

* Install the SAP Java Connector
* Install the SAP Transport Requests that support Read from SAP

Note: You will not be able to use the Read form SAP stage until you perform these steps.

1. Install the SAP Java Connector (SAP JCo).
a) Go to the SAP Marketplace and log in with your SAP Marketplace credentials.
b) Go to SAP JCo Connector > Tools & Services.
c) Download SAP JCo to your system.
d) Unzip the SAP JCo zip file to a temporary location.
e) Stop the Spectrum™ Technology Platform server.
f)  Copy the .jar file to the following folder on the Spectrum™ Technology Platform server:

SpectrumFolder\server\app\lib

g) Copy the .dll file to the following folder on the Spectrum™ Technology Platform server:

SpectrumFolder\server\bin\wrapper
h) Start the Spectrum™ Technology Platform server.
2. Install the SAP Transport Requests that support Read from SAP.

Note: The following steps should be performed by your SAP Basis administrator.

a) Inthe Spectrum™ Technology Platform installer, go to the folder AP Data Integration
Objects\Enterprise System Connectors.
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b) Deploy the SAP Transport Requests contained in this folder. See your SAP documentation
for instructions on deploying SAP Transport Requests.

Integrating with SAP Interaction Center WebClient

Before continuing verify these:

* The Interaction Center WebClient user has the CRM_UI_PROFILE parameter ID with IC_ AGENT
as the Parameter Value

» The duplicate option is activated in SPRO under ICWC (SPRO > CRM > ICWC > Define Account
Identification Profiles)

To integrate Spectrum™ Technology Platform with SAP Interaction Center WebClient, you need to
install supporting databases and dataflows on the Spectrum™ Technology Platform server, then
configure your SAP system to communicate with Spectrum™ Technology Platform. Once you do
this, users of SAP Interaction Center WebClient will have access to address validation and geocoding
functionality from within SAP Interaction Center WebClient.

Note: The SAP Interaction Center WebClient is supported only for new installations of Data
Quality connector.

1. Onthe Spectrum™ Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Logate

Universal Addressing Module - U.S. Database UAM_US

2. When you install the SAP Module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into Spectrum™ Technology Platform.
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a) Ifyou are adding the Address Now Module, Enterprise Tax Module, or Universal Addressing
Module to an existing installation, open Spectrum™ Technology Platform Enterprise Designer,
select View > Server Explorer, and delete this dataflow:
SAPValidateAddressWithCandidates.

b) Goto: SpectrumFolder\server\modules\dataflows\sap.

c) Review the following table then copy the applicable dataflow files to:

SpectrumFolder\server\app\import

If you are installing this set of
modules

Copy these dataflow files to the import folder

Universal Addressing Module

SAPValidateAddressWithCandidates.df
SAPValidateAddressWithCandidates.UAM.df

Enterprise Geocoding Module

SAPValidateAddressWithCandidates.EGM.df

Enterprise Geocoding Module
Universal Addressing Module

SAPValidateAddressWithCandidates. UAM_EGM.df

Enterprise Tax Module
Universal Addressing Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df

Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module

SAPValidateAddressWithCandidates. UAM_ETM_EGM.df

Universal Addressing Module without
Loqate

SAPValidateAddressWithCandidate_ UAM.df

Universal Addressing Module without
Loqate
Enterprise Tax Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates. UAM_ETM.df
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Copy these dataflow files to the import folder

Universal Addressing Module with
Logate

ValidateAddressWithCandidates_ UAM_Loqate.df

Universal Addressing Module with
Logate
Enterprise Geocoding Module

ValidateAddressWithCandidates_ UAM_Loqate_ EGM.df

Universal Addressing Module with
Logate
Enterprise Tax Module

ValidateAddressWithCandidates_ UAM_Logate_ ETM.df

Universal Addressing Module with
Loqate

Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates UAM_Logate EGM_ETM.df

Universal Addressing Module, Logate
only

ValidateAddressWithCandidates_Loqgate.df

Universal Addressing Module, Logate
only
Enterprise Geocoding Module

ValidateAddressWithCandidates_Logate EGM.df

Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_ EGM.df

Enterprise Tax Module

ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ ETM.df
SAPBatchAssignGeoTAXInfo.df

Note: If errors occur in Management Console or Enterprise Designer, delete the
contents of <WindowsTemporaryDirectory>\glAssemblies, where
<WindowsTemporaryDirectory> is one of these: % TMP%, % TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C: \Documents and
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Settings\<USERNAME>\Local Settings\Temp\glAssemblies. After deleting
the contents of this folder, log in again.

3. Import .SAR files.

A .SAR file is a file that contains a third-party add-on package for SAP, such as the Spectrum™
Technology Platform SAP Module. The .SAR file is located on the Spectrum™ Technology
Platform installer in the SAP Objects folder. For information about importing .SAR files into
SAP applications, see your SAP Basis administrator.

4. Activate BC sets for CRM installation where ICWC is required (IC Web Client) - You have
already assigned CRM UI Profile parameter to the user with appropriate roles and
authorization.

1.

2.

5.

Log-on to the client where the settings for the Spectrum™ Technology Platform SAP Module
is to be configured.

Enter the transaction code SCPR20. This activates BC sets and places the default entries
on the Spectrum™ Technology Platform customizing tables.

In the BC Set field, enter keyword *hsgrpl* and find all the BC Sets in this namespace.
Activate it with the options Overwrite All Data and Default Mode.

|E7Activati0n Options
- _ SAPG ==
Caution You have started the BC Set activation If you continue, new data ‘.”"
records will be created andfor existing ones ovenaritten. E
Activation Information Activation Options
ctivated By} FSALYADOR Overwrite Data
DateiTime: 15.08.2008 ¢ 16:06:05 @ Overwtite All Data
SystemiClient: DCh L Izl O Default Yalues not Overwritten
‘Warkhench Regst: Mot Reguired
Customizing Regst DCEKE00105 Select Activation Maode
Activation Links: Create Locally @ Default Mode (Reccomend)
O Expert Mode
Activation Languages: German
English H
[«]
[
TR

Select and activate the BC sets with the activation options set to Overwrite All Data and
Expert Mode

Note: Activate these BC sets in the order listed.

/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/BCSET_BC_BAS_PV
JHSGRP1/FUZZY_SEARCH_INPUT_PARAM
/HSGRP1/ICWC_SETTINGS
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/HSGRP1/MERGE_SETTINGS
/HSGRP1/ONP_PO_CRM
/HSGRP1/SPOD_CONFIG
/HSGRP1/SPOD_IN_TABLE
/HSGRP1/SPOD_OPT_TABLE
/HSGRP1/SPOD_OUT_TABLE
/HSGRP1/SPOD_PO_CRM
/HSGRP1/ICWC_SCRN_CFG

Note: Ignore any activation error or warnings with BC Set:
/HSGRP1/ICWC_SCRN_CFG

5. Set up the RFC destination for Spectrum OnPremise

a)
b)
c)
d)
e)
f)
g9)
h)

i)
)
k)

Enter transaction code sM509.

Click Create.

In the RFC Destination field, enter a name of your choice.

In the Connection Type field, enter G (HTTP connection to external server).
In the Description 1 field, enter a meaningful description.

Press the Enter key.

Click the Technical Settings tab.

In the Target Host field, enter the computer name or IP Address of the Spectrum™
Technology Platform server.

In the Service No field enter 8080.

Click the Special Options tab.

Select No Timeout.

Note: These steps are not valid for Spectrum OnDemand as it is not supported for
ICWC.

6. Use these steps to import the upload the ICWC configuration file
(CQ7 A1l Screen Configurations.cfg). The file resides on the Spectrum™ Technology
Platform installer at this location: SAP Objects\SAP CRM 7.0\data\inst cs7.

1.
2.

On the initial screen, go to Tcode 'SE38' and enter ' /HSGRP1/IMPORT SCRN CFG'
Click Execute.
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= Progam Edit Goto Utiities Environment System  Help

=
@ | /nse3s | v| « e 2/ R %
ABAP Editor: Initial Screen
ao /'GE- ta (3] 1F [0 BD @ opebuggng & With Varant  [©Variants
Execute (F8)

Program |/iiscre1/ MpoRT_scrw cee || (M Create
 Subobjects

*)Source Code

Variants

Attributes

") Documentation

) Text elements

:Gf’ Display | II Change ]

Locate the CQ7 All Screen Configurations.cfg file and select it.

3.
4. Grant access as shown in the image below.
E progam  ESt  Goto Wi Emgeement  Sptem  Heb
e MR aee aon t=l-alf 21
ABAP Editor: Initial Screen
it A G WO Dosumng  Twehvamnt  [Tveess
Frogram ESGREL/ INPORT_SCRN_CFG I‘: reate
Slobprts

=i Source Codw
Varants
oo T —,

Docurmentaton
T alerranti
- The system is trying to access the file
B Duley ¢ owe D:\Pitney Bowes\Avengrid-Comenitl_HSGRP1_ICOWC_SCRN_CFG.bes

Do you want to grant access to this file?
[romember My Docsion )

Ce) o= | [ e |

5. Goto tcode SE16.
Enter Table Name as BSPC_ DL XMLSTRX2.

7. Click Table Content icon.

o
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= Table Edit Goto Settings Utiities System  Help

Y =53 ‘«Hle@@ 2hk 00D T e

Table Name BSPC_DL_XMLSTRX2

8. Click the Execute icon.
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/] fl«gd eae 2 PINE o

Data Browser: Table BSPC_DL_XMLSTRX2: Selection Screen
-%n E: [i] mMumber of Entries
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OBJECT_TYPE
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MASTERLANG ]

]]]— |
g g8 8888888

BaREEEERERRE [
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9. Check these entries:

Dats Srowser: Table BSPC_DIL_XMLSTRXZ Select Emtries 7
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e
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Note: Ignore errors or warning messages related to missing users, as shown in the image
below.

Report /HSGRP1/IMPORT SCEN_CFG

Config for

TELOARRSEE BE_ADDR STANDARDADDRESS Same as in the file

4T6AT1DC BF_ADDR STANDARDADDRESS Same as in the file

ICCMP BP DETAIL  BUPRDETATLB2R Same as in the file

BP_ADDR STANDARDADDRESS Same as in the file

ICCMP BP DETAIL BUFADETAILEZE Samet as in the file
ICCMP _BP DETAIL  BUPACRERTE Same as in the file

BE_ADDR STANDARDADDRESS Same as in the file

STANDARDADDRESS Same as in the file

CATECREATIE Same a3 in the file
“ATECREATE GW_RIMTH was not found

for
for

g for

TEBC326639371FCEE
for F5518F5CHE3(
for 43CR2B0ER EET75D0
for 461FTE4BEAG4ES23415
for A4SDFCEEBFZETE4ET
for REF3L5SSS0BE

for SB42R1ITRADBFSECO8

7. Set up the Spectrum™ Technology Platform Logging Object
a) Enter transaction code SLGO.
b) Click New Entries.
c) Inthe Object column, enter /HSGRP1/DQC.
d) In the Object text column, enter DQC Logging.
e) Save the change.

8. Enable the Pitney Bowes IC WebClient Enhancement Set.
a) Enter the transaction code sM30.
b) Inthe Table/View field, enter BSPWDV_EHSET ASG.
c) Click Maintain.
d) Click New Entries.
e) Inthe Client field, enter the client number where the enhancement set will take effect.
f) Inthe Enhancement Set field, enter /HSGRP1/ENHANCEMENT SET.

9. Add the IC WebClient Configurations.
a) Enter the transaction code BSP_WD CMPWB.
b) Inthe Component field, enter ICCMP_BP DETAIL.
c) Click the check icon.
d) Inthe Enhancement Set field, enter /HSGRP1/ENHANCEMENT SET.
e) Click Display.
f) Expand the Views folder and select
/HSGRP1/BUPA_CMP_VIEW/BuPaDetailSelectDuplCustomer.
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Structure of Component ICCMP_BP_DETAIL - Enhancement Set [HSGRP1/E
[ Test|[& poL mode! |[=] 2| [ wizard Log |6 4P Reference MG | (B Find view Layout

&aBrowser Component Structure yiew Mavigatian Co
S=BOL Model Browser

EaRuntime Repository Editar = EEIIHSGRF‘1IEIUPA_CMP_VIEWIEIuPa
b [ Favorfies ~ [ HEGRP1BUPA_CMP_VIEWIB!

<] ]

= 02 View Controller
= @5 BuPaDetailSelectDuplC
@ Implementation Clas
b () Context
[ [J Context related Meth
> (J Breadcrumbs and M
[
[

= g% Component
<ﬁ Companent Cantraller

I B windows

[» %% Custom Cantrallers

— (B Views
[ HSGRP1/BUPA_CMP_VIEW/BUPADetallEmptySelect
El /HSGRP1/BURPA_CMP_VIEWIBUP aDetailSelectDuplCustomer:
=]

(3 Toalbar related Meth
(3 controller Initializatic

g) Click the Configuration tab.
h) On the edit screen select Full Name, Telephone, Street, City and Country context then click
the right arrow button and arrange them in this order:

Full Name
Telephone
Street
City
Country

i) Save the configuration.

10. If you will be using French address validation, you must install the Data Normalization Module
table cdg-TableLookup-SAP. tba on the Spectrum™ Technology Platform server. For more
information, see the Spectrum™ Technology Platform Installation Guide.

Compatibility Matrix

These tables give a list of SAP add-on versions and system kernel levels that are compatible with
the various releases of Spectrum™ Technology Platform for installation and upgrade of ECC 6.0
and CRM 7.0.

Table 2: Compatibility Matrix for New Deployment

Spectrum Release SAP Add-on Version SAP System Kernel Level
10.x 10.x 741 and above
11.x 11.x 741 and above
12.x 12.x 741 and above
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Table 3: Compatibility Matrix for Upgrade

Spectrum Release SAP Add-on Version SAP System Kernel Level
10.x Any to 10.x 741 and above
11.x Any to 11.x 741 and above
12.x 12.x 741 and above

This table gives the compatibility matrix for new deployment of SAP S/4 HANA 1610 for Spectrum™
Technology Platform 12.x

Spectrum Release SAP S/4 HANA 1610 Add-on Version SAP S/4 HANA 1610
System Component Level

New deployment

12.x 12.x 751 (SAP_BASIS)

75B (SAP_ABA)

Note: Itis recommended that you contact the Pitney Bowes representative or coordinator
assigned to you before starting the process.

M

This table gives the compatibility matrix for new deployment of SAP S/4 HANA 1709 for Spectrum”
Technology Platform 12.x

Spectrum Release SAP S/4 HANA 1709 Add-on Version SAP S/4 HANA 1709
System Component Level

New deployment

12.x 12.x 752 (SAP_BASIS)

75C (SAP_ABA)

Note: It is recommended that you contact the Pitney Bowes representative or coordinator
assigned to you before starting the process.

The SAP Data Quality Connector is certified for ECC 6.0 EHP 7.0 and CRM 7.0 EHP 3.0 with
HANA database.
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Configuring SugarCRM

Integrating with SugarCRM

To integrate Spectrum™ Technology Platform with SugarCRM, you must install the supporting

databases and dataflows on the Spectrum™ Technology Platform server, and deploy the Spectrum™
Technology Platform solution on your SugarCRM. Once you do this, users of SugarCRM will have
access to address validation, geocoding, and duplicate detection functionality from within SugarCRM.

Before you begin:
Entities Supported:
You can validate and geocode the addresses of the entities:

» Accounts
» Contacts
* Leads

Supported SugarCRM Versions
SugarCRM 7.7.1.1

Browse to the the folder Sugar CRM DQ Objects\sugarcrmin the Spectrum™ Technology
Platform installation package and copy the file PBSugarCRMConnector. zip to any location on
your SugarCRM server.

1. If you are using Spectrum™ Technology Platform for address validation or geocoding, install
the databases required to perform address validation and geocoding and define database
resources for each database.

Note: If you are using Spectrum™ Technology Platform for duplicate detection only, you
can skip this step.

You must give the database resources these names:

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Universal Addressing Module - Canada Database Canada
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Database Required Name for Database Resource
Universal Addressing Module - Logate Database Logate
Universal Addressing Module - U.S. Database UAM_US

Note: You must install the Delivery Point Validation (DPV) data and the Residential
Delivery Indicator (RDI) data in order to perform DPV and RDI processing on U.S.
addresses.

2. Import the SugarCRM Module dataflows into your Spectrum™ Technology Platform server.
a) On the Spectrum™ Technology Platform server, open this folder:

SpectrumFolder\server\modules\sugarcrm

Note: This folder is only available if you have installed the SugarCRM Module.

b) As mentioned in the table below, copy the applicable dataflow files to the import folder:

SpectrumFolder\server\app\import

If you have installed this set of Copy these dataflow files to the import folder
modules

Advanced Matching Module
GenerateMatchKey.df

GenerateMatchScore.df
GenerateSearchKey.Consonant.df
GenerateSearchKey.df
GenerateSearchKey.Metaphone.df
GenerateSearchKey.Substring.df

. . . ValidateAddresswithCandidates_UAM.df
Universal Addressing Module without

Logate

) . . ValidateAddressWithCandidates UAM_EGM.df
Universal Addressing Module without

Logate
Enterprise Geocoding Module

) . . ValidateAddressWithCandidates_ UAM_Loqate.df
Universal Addressing Module with

Logate
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If you have installed this set of Copy these dataflow files to the import folder
modules

Universal Addressing Module with SugarCRMValidateAddressAndGenerateMatchKey.df
Loqate

Enterprise Geocoding Module ValidateAddressWithCandidates UAM_Loqate EGM.df

) ) ValidateAddressWithCandidates Loqate.df
Universal Addressing Module, Logate

only

) ) ValidateAddressWithCandidates Loqgate EGM.df
Universal Addressing Module, Logate

only
Enterprise Geocoding Module

. ) GeocodeUSAddressWithCandidates.df
Enterprise Geocoding Module

3. Import the Pitney Bowes SugarCRM module into your SugarCRM system.
a) Log in to SugarCRM as an administrator.
b) In the profile dropdown at the top right corner, click Admin.

c) Inthis Adminstration screen, in the Developer Tools section, click Module Loader.
The Module Loader screen opens.

d) If you are integrating your SugarCRM system with Spectrum™ Technology Platform for the
first time, you must upload the SugarCRM Connector module of your SugarCRM system:

1. Upload the ZIP file PBSugarCRMConnector. zip of Spectrum copied earlier to the
system, using the file uploader field in the centre of the page.

2. Click Upload.

3. Click Confirm. An entry for the Pitney Bowes package now shows in the bottom grid.

e) Once the Pitney Bowes package is uploaded into the system, or if it has been uploaded
previously into your SugarCRM system but is uninstalled:

1. Click Install against the Pitney Bowes package entry in the bottom grid on the Module
Loader screen.
2. On the License screen, select Accept, then click Commit.

f) In the profile dropdown at the top right corner, click Admin.

g) Inthis Adminstration screen, in the System section, click Repair.
The Repair screen opens.

h) Click Quick Repair and Build.
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The existing SugarCRM configurations are rebuilt to incorporate the custom Objects and
Object Layouts imported with the SugarCRM Connector module. The logs are displayed.

Spectrum's SugarCRM Connector module is now successfully integrated with your SugarCRM
system.

The menu item Administration > PB Service Configuration is now available.
Creating a Connection to Spectrum

Once the SugarCRMConnector module of Spectrum™ Technology Platform is uploaded successfully
in your SugarCRM, you can create a connection to the Spectrum server.

1. Login to your SugarCRM system as an Administrator.
2. Go to Administration > PB Service Configuration.
3. Click Create.
4

In the Name field, enter the desired name for the connection. For example,
PB SpectrumConnection.

5. In the Server Name field, enter the server name or IP address of the Spectrum™ Technology
Platform server.

6. Inthe Port field, enter the port used by the Spectrum™ Technology Platform server for HTTP
communication. By default the portis 8080.

7. Inthe User Name field, enter the Spectrum™ Technology Platform user name.

8. Inthe Password field, enter the password for the Spectrum™ Technology Platform user.

9. Ifyou wish to run the duplicate detection feature provided by the Pitney Bowes Address Validation
bundle:

» Check Duplicate Detection.

* In the Threshold field, enter a value between 0 and 100, both inclusive. If you leave this field
blank, the default threshold value of 30 is used. The Pitney Bowes Address Validation service
fetches those records as duplicate whose match score is equal to or higher than the threshold
match score.

For more information, see Threshold.

10. Before saving the connection, click Test Connection to verify the entered credentials for the
Spectrum server.
11. Once the Spectrum connection details are tested successfully, click Save.

Note: You can either test a connection before clicking Save, or test an existing connection
by first opting to Edit it.

You can now use this connection to validate and geocode the addresses of records in your SugarCRM
system using the Spectrum™ Technology Platform.
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Note: Only one connection to the Spectrum™ Technology Platform can exist at a time. To
create another connection to Spectrum™ Technology Platform, you can either delete the
existing connection and create a new one, or edit the existing connection.

Configuring Microsoft Dynamics CRM

Integrating with Microsoft Dynamics CRM

To integrate Spectrum™ Technology Platform with Microsoft Dynamics CRM , you must install the
supporting databases and dataflows on the Spectrum™ Technology Platform server, and deploy
the Spectrum™ Technology Platform solution on your Microsoft Dynamics CRM. Once you do this,
users of Microsoft Dynamics CRM will have access to address validation, geocoding, and duplicate
detection functionality from within Microsoft Dynamics CRM.

Note: End users who use Internet Explorer must use Internet Explorer 10 or 11. Older
versions of Internet Explorer are not supported. All versions of Chrome and Firefox are
supported.

Before you begin, confirm that you are using a compatible version of Microsoft Dynamics. These
versions are supported:

Microsoft Dynamics CRM 2013

Microsoft Dynamics CRM 2013 SP1

Microsoft Dynamics 2015

1. If you are using Spectrum™ Technology Platform for address validation or geocoding, install
the databases required to perform address validation and geocoding and define database
resources for each database.

Note: If you are using Spectrum™ Technology Platform for duplicate detection only, you
can skip this step.

You must give the database resources these names:

Database Required Name for Database Resource
Enterprise Geocoding Module - Canada Database IGEO_CAN
Enterprise Geocoding Module - U.S. Database EGM_US
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Database Required Name for Database Resource
Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Logate Database Logate

Universal Addressing Module - U.S. Database UAM_US

Note: You must install the Delivery Point Validation (DPV) data and the Residential
Delivery Indicator (RDI) data in order to perform DPV and RDI processing on U.S.
addresses.

2. Import the Microsoft Dynamics CRM Module dataflows into your Spectrum™ Technology Platform
server.

a) On the Spectrum™ Technology Platform server, open this folder:

SpectrumFolder\server\modules\dataflows\mscrm
Note: This folder is only available if you have installed the Microsoft Dynamics CRM
Module.
b) As mentioned in the table below, copy the applicable dataflow files to the import folder:

SpectrumFolder\server\app\import

If you have installed this set of Copy these dataflow files to the import folder
modules

Advanced Matching Module
GenerateMatchKey.df

GenerateMatchScore.df
GenerateSearchKey.Consonant.df
GenerateSearchKey.df
GenerateSearchKey.Metaphone.df
GenerateSearchKey.Substring.df

. ) . ValidateAddresswithCandidates UAM.df
Universal Addressing Module without

Loqate

. ) . ValidateAddressWithCandidates UAM_EGM.df
Universal Addressing Module without

Loqate
Enterprise Geocoding Module
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If you have installed this set of Copy these dataflow files to the import folder
modules

. ) . ValidateAddressWithCandidates UAM_Loqate.df
Universal Addressing Module with

Loqate

Universal Addressing Module with SugarCRMValidateAddressAndGenerateMatchKey.df
Loqate

Enterprise Geocoding Module ValidateAddressWithCandidates UAM_Loqate EGM.df

) ) ValidateAddressWithCandidates Loqate.df
Universal Addressing Module, Logate

only

) ) ValidateAddressWithCandidates Loqgate EGM.df
Universal Addressing Module, Logate

only
Enterprise Geocoding Module

. ) GeocodeUSAddressWithCandidates.df
Enterprise Geocoding Module

3. Import the Microsoft Dynamics CRM Module into your Microsoft Dynamics CRM system.
a) Inthe Spectrum™ Technology Platform installation package, browse to this folder:

MS CRM Objects\Proxy

b) Copy the file netProxy.aspx to this folder on your Microsoft Dynamics CRM server:

MicrosoftDynamicsCRMInstallation\CRMWeb

c) Copy the file netProxy.d11 to this folder on your Microsoft Dynamics CRM server:

MicrosoftDynamicsCRMInstallation\CRMWeb\Bin

d) Log in to Microsoft Dynamics CRM as an administrator.

e) Click Microsoft Dynamics CRM then click Settings.

f) Click Solutions.

g) Click Import.

h) Browse to the Spectrum™ Technology Platform installation package and select the file:

MS CRM Objects\mscrm\PBMSDynamicsCRMConnector 4 0 0 managed.zip

i) Click Next then Publish All Customizations.
i) Restart the Microsoft Dynamics CRM server.
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4. Define the connection between Microsoft Dynamics CRM and the Spectrum™ Technology
Platform server.
a) Log in to Microsoft Dynamics CRM as an administrator.
b) Click Microsoft Dynamics CRM > Settings.

c) Click Settings > Pithey Bowes. You will have to scroll to the right to find the Pitney Bowes
link.

d) Click Administration.

e) Click New.

f) In the Name field, enter PB.

g) Inthe Server Name field, enter the server name or IP address of the Spectrum™ Technology
Platform server.

h) Inthe Port field, enter the port used by the Spectrum™ Technology Platform server for
HTTP communication. By default the port is 8080.

i) Inthe Account ID field, enter the Spectrum™ Technology Platform user name.

i) Inthe Password field, enter the password for the Spectrum™ Technology Platform user.

k) Click Save

The Microsoft Dynamics CRM system now has access to address validation and, optionally,
geocoding services on the Spectrum™ Technology Platform server.
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In this section
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Support

Technical Support

If you run into an issue, Pitney Bowes Technical Support can help guide you to a solution. When
you contact Pitney Bowes Technical Support, please provide the following information:

* A description of the task you were performing
» The level or version of your operating system
* The patch level or service pack

» The log file located in your install directory at:
<SpectrumInstallationLocation>\server\app\repository\logs\wrapper.log

Contact information for Technical Support can be found at:
support.pb.com/spectrum

Note: If you purchased Spectrum™ Technology Platform through a third-party partner, please
contact the partner for technical support.

Documentation

Product documentation can be found at:

support.pb.com/spectrum
Digital Insights

Digital Insights is an online resource for Pitney Bowes leadership to share innovations, goals, and
product news, as well as exchange ideas with visitors. You can access Digital Insights at:

blogs.pb.com/digital-insights/
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Notices




Copyright

© 2018 Pitney Bowes. All rights reserved. Maplnfo and Group 1 Software are trademarks of Pitney
Bowes Software Inc. All other marks and trademarks are property of their respective holders.
USPS® Notices

Pitney Bowes Inc. holds a non-exclusive license to publish and sell ZIP + 4® databases on optical
and magnetic media. The following trademarks are owned by the United States Postal Service:
CASS, CASS Certified, DPV, eLOT, FASTforward, First-Class Mail, Intelligent Mail, LACSL'nk,
NCOA""™ PAVE, PLANET Code, Postal Service, POSTNET, Post Office, RDI, Suite"™ , United
States Postal Service, Standard Mail, United States Post Office, USPS, ZIP Code, and ZIP + 4.
This list is not exhaustive of the trademarks belonging to the Postal Service.

Pitney Bowes Inc. is a non-exclusive licensee of USPS® for NCoA-k® processing.

Prices for Pitney Bowes Software's products, options, and services are not established, controlled,
or approved by USPS® or United States Government. When utilizing RDI™ data to determine
parcel-shipping costs, the business decision on which parcel delivery company to use is not made
by the USPS® or United States Government.

Data Provider and Related Notices

Data Products contained on this media and used within Pitney Bowes Software applications are
protected by various trademarks and by one or more of the following copyrights:

© Copyright United States Postal Service. All rights reserved.

© 2014 TomTom. All rights reserved. TomTom and the TomTom logo are registered trademarks of
TomTom N.V.

© 2016 HERE

Fuente: INEGI (Instituto Nacional de Estadistica y Geografia)
Based upon electronic data © National Land Survey Sweden.
© Copyright United States Census Bureau

© Copyright Nova Marketing Group, Inc.

Portions of this program are © Copyright 1993-2007 by Nova Marketing Group Inc. All Rights
Reserved

© Copyright Second Decimal, LLC
© Copyright Canada Post Corporation

This CD-ROM contains data from a compilation in which Canada Post Corporation is the copyright
owner.

© 2007 Claritas, Inc.

The Geocode Address World data set contains data licensed from the GeoNames Project
(www.geonames.org) provided under the Creative Commons Attribution License ("Attribution
License") located at http://creativecommons.org/licenses/by/3.0/legalcode. Your use of the
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Copyright

GeoNames data (described in the Spectrum™ Technology Platform User Manual) is governed by
the terms of the Attribution License, and any conflict between your agreement with Pitney Bowes
Software, Inc. and the Attribution License will be resolved in favor of the Attribution License solely
as it relates to your use of the GeoNames data.
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